Notice

Copyright and trademark notice

© Copyright 2009–2013 Zendesk, Inc. All rights reserved.

Zendesk® Agent Guide

The information in this document is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Zendesk, Inc. Zendesk, Inc. assumes no responsibility or liability for any errors or inaccuracies that may appear in this document. The software described in this document is furnished under license and may only be used or copied in accordance with the terms of such license.

Zendesk is a registered trademark of Zendesk, Inc. All other trademarks are the property of their respective owners.

Zendesk - 989 Market St, Ste 300 - San Francisco - CA 94103 - USA

www.zendesk.com
Contents

Zendesk versions.................................................................................................................9

Chapter 1: Updating your user profile................................................................................ 11
    Adding a photo to your profile..........................................................................................13

Chapter 2: Managing your tickets........................................................................................15
    Viewing tickets.................................................................................................................. 15
    Knowing when other agents are viewing a ticket.............................................................16
    About ticket fields.............................................................................................................16
    Adding comments to tickets.............................................................................................18
        Adding attachments to ticket comments..................................................................19
        Changing a public comment to private......................................................................20
    Quickly assigning yourself to a ticket..............................................................................20
    Viewing a ticket's events and notifications......................................................................20
    Asking for more information from the requester.............................................................21
    Asking for information from a third party........................................................................21
    Problem and incident tickets..........................................................................................22
    Solving a ticket and understanding how it is closed.......................................................22

Chapter 3: Using views to manage ticket workflow...........................................................23
    Selecting views.................................................................................................................. 24
    Viewing your recent tickets.............................................................................................25
    Viewing the next ticket in a view......................................................................................26
    Viewing the tickets in a view............................................................................................27
    Adding views.....................................................................................................................28
        Building view condition statements.......................................................................28
        Setting formatting options........................................................................................29
        Setting the view's availability (administrators only)..................................................32
    Editing and cloning views...............................................................................................33
    Reordering views.............................................................................................................34
    Deleting and deactivating views.....................................................................................34
    Exporting a view to a CSV file.........................................................................................35

Chapter 4: Manually assigning a ticket to yourself, another agent, or a group.............. 37

Chapter 5: Copying someone else (CC) on a ticket.........................................................39

Chapter 6: Deleting tickets.................................................................................................41
    Deleting more than one ticket at a time............................................................................41

Chapter 7: Merging tickets.................................................................................................43

Chapter 8: Creating a ticket on behalf of the requester...................................................47
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Changing the ticket requester</td>
<td>49</td>
</tr>
<tr>
<td>10</td>
<td>Creating a follow-up for a closed ticket</td>
<td>51</td>
</tr>
<tr>
<td>11</td>
<td>Working with problem and incident tickets</td>
<td>53</td>
</tr>
<tr>
<td>12</td>
<td>Sharing tickets</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Unsharing tickets</td>
<td>57</td>
</tr>
<tr>
<td>13</td>
<td>Bulk updating, deleting, and merging tickets</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Bulk updating tickets</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Bulk deleting tickets</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Bulk merging tickets</td>
<td>61</td>
</tr>
<tr>
<td>14</td>
<td>Viewing, recovering, and deleting suspended tickets</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>Viewing suspended tickets</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>Recovering or deleting suspended tickets</td>
<td>63</td>
</tr>
<tr>
<td>15</td>
<td>Formatting ticket comments with Markdown</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Markdown examples</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Bold and italic</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Lists</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Block quotes</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Inline code and code blocks</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Images and links</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Headings</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Adding an image to your agent signature</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Adding Markdown to macros</td>
<td>71</td>
</tr>
<tr>
<td>16</td>
<td>Adding and managing end-users</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Adding end-users</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Adding user contact information</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Viewing and editing a user's profile</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>Deleting users</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>Merging Users</td>
<td>77</td>
</tr>
<tr>
<td>17</td>
<td>Merging a user's duplicate account</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>How user data is merged</td>
<td>80</td>
</tr>
<tr>
<td>18</td>
<td>Suspending a user</td>
<td>81</td>
</tr>
<tr>
<td>19</td>
<td>Using macros to update and add comments to tickets</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>Zendesk macros to get you started</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>Applying macros to tickets</td>
<td>84</td>
</tr>
</tbody>
</table>
Zendesk® Agent Guide | TOC | 7

Applying macros to tickets in a view.......................................................................................... 84
Creating macros....................................................................................................................... 84
  Creating personal macros....................................................................................................... 85
  Creating shared macros (administrators only)........................................................................ 85
  Building macro action statements........................................................................................ 86
Editing and cloning macros......................................................................................................... 87

Chapter 20: Creating macros from existing tickets............................................................... 89

Chapter 21: Organizing your macros....................................................................................... 91
  Reordering the list of macros.................................................................................................... 91

Chapter 22: Searching the data in your Zendesk................................................................. 93
  Simple text searches................................................................................................................. 93
  Identifying items in search results......................................................................................... 94
  Using search filters.................................................................................................................... 94
  Using search keywords............................................................................................................. 95

Chapter 23: Providing live chat support with Zendesk Chat.............................................. 97
  Workflow................................................................................................................................. 97
  Making yourself available for chat......................................................................................... 97
  Monitoring for chat requests............................................................................................... 98
  Accepting a chat session....................................................................................................... 99
  Identifying the user and handling new accounts............................................................... 100
  Working with chat tickets..................................................................................................... 101
  Searching for chat tickets..................................................................................................... 102

Chapter 24: Taking inbound telephone calls with Zendesk Voice.................................... 103
  The incoming call workflow: how live calls and voicemails become tickets..................... 103
    Making yourself available to receive calls........................................................................ 103
    Receiving a call.................................................................................................................. 104
    Identifying the caller and handling new user accounts.................................................. 105
    Accepting a phone call....................................................................................................... 106
    Completing the new voice ticket...................................................................................... 107
    When the caller leaves a voicemail.................................................................................. 108
    Merging tickets when a new call is about an existing ticket......................................... 109
    Forwarding calls to a different phone number.................................................................. 109
    Searching for voice tickets.............................................................................................. 110

Chapter 25: Making outbound telephone calls using Zendesk Voice............................ 111
  Outbound call pricing.......................................................................................................... 111
  Calling from your browser or telephone........................................................................... 111
  Making outbound calls....................................................................................................... 112
  Creating a view of outbound calls..................................................................................... 114
  Searching for outbound call tickets.................................................................................... 115

Chapter 26: Posting a forum topic based on a ticket......................................................... 117
Chapter 27: Creating a ticket from a forum topic (Zendesk Classic).............................119

Chapter 28: Adding a screencast to a ticket or forum topic........................................... 121
  Adding a screencast to a ticket...................................................................................... 121
  Adding a screencast to a forum topic.......................................................................... 123

Chapter 29: Passing an email to your support address.................................................... 127
  Forwarding an email...................................................................................................... 127
    Enabling the forwarding option for agents in Zendesk............................................. 127
    Specifying the requester in the forwarded email...................................................... 128
    Configuring Microsoft Outlook 2007 and 2010......................................................... 128
  Redirecting an email...................................................................................................... 128
    Microsoft Outlook 2007 and 2010......................................................................... 129
    Microsoft Outlook:Mac 2011.................................................................................. 129
    Mail (Mac OS)............................................................................................................ 129
    Mozilla Thunderbird................................................................................................. 129
    Eudora....................................................................................................................... 129
    Evolution.................................................................................................................... 130

Chapter 30: Viewing the original email, including full HTML.......................................131

Chapter 31: Marking a ticket as spam and suspending the requester............................133
Zendesk versions

On 9/12/12, we released a new version of the agent and administrator interface of Zendesk. During the beta period, this was known as 'Lotus'. The Zendesk you knew before 9/12 is now referred to as 'Zendesk Classic'. In this guide, we refer to the new version as simply 'Zendesk' and qualify that with 'new' or 'current version' when needed to distinguish between the two versions. Therefore, the instructions for navigating the Zendesk user interface are given first for the new version and then again for the Classic version, which are noted as 'Zendesk Classic'.
## Updating your user profile

Every user in your Zendesk has a profile that contains essential information such as the contact email address, alternate identities, the user's organization, and so on. This includes the support staff (administrators and agents) and the people you support (your end-users).

The following table describes the profile information that can be set for administrators and agents.

**Zendesk Classic**: The presentation of information in your profile is different than what is presented in the table if you are using Zendesk Classic.

<table>
<thead>
<tr>
<th>Profile data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Your real name. If you don't define an alias (see below), the name is used on all communications with end-users. To change your name in new Zendesk, click your name on the profile page.</td>
</tr>
<tr>
<td><strong>Role</strong></td>
<td>Defines a user's function and access level in your Zendesk. There are three user types: End-user, Agent, Administrator. Only administrators can change a user's role. For more information, see Understanding Zendesk user roles in the Zendesk Administrator Guide.</td>
</tr>
<tr>
<td><strong>Groups</strong></td>
<td>A collection of agents created by an administrator. Agents must be assigned to at least one group by an administrator, but they can be assigned to more than one. Administrators can add and edit groups, agents cannot. For more information, see About organizations and groups in the Zendesk Administrator Guide.</td>
</tr>
<tr>
<td><strong>Alias</strong></td>
<td>Alternative name to use on all communications with end-users instead of your real name. Leave this field blank if you want to use your real name on your communications. This option is available for Plus and Enterprise accounts only. For more information, see Adding an agent alias in the Zendesk Administrator Guide. <strong>Zendesk Classic</strong>: This option is called Display name.</td>
</tr>
<tr>
<td><strong>Signature</strong></td>
<td>Closing line added to your email notifications when you make public ticket comments.</td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td>Email addresses associated with your profile. The first email address is your primary email address for all email communications. You can add more email addresses to your profile by clicking Add contact.</td>
</tr>
<tr>
<td>Profile data</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Agent forwarding</td>
<td>Office phone or mobile phone you’d like to forward voice calls to instead of answering calls via the browser. You can test the number you enter to make sure calls forward properly.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Other contact information including your Twitter handle, Facebook page, and Google account. You can also add secondary email addresses.</td>
</tr>
<tr>
<td>Phone</td>
<td>Personal telephone number for your profile.</td>
</tr>
<tr>
<td>Tags</td>
<td>Any tags you want automatically added to new tickets you create. Separate tags with a space. Tags are added to new tickets only, not updated tickets. This is an optional feature and your Zendesk may not have enabled user tagging. For more information about user tags, see Adding tags to users and organizations in the Zendesk Administrator Guide.</td>
</tr>
<tr>
<td>Organization</td>
<td>A collection of users (both end-users and agents) created by an administrator. Agents can be a member of only one organization. If your Zendesk uses organizations, both administrators and agents can add or edit their organization. For more information, see About organizations and groups in the Zendesk Administrator Guide.</td>
</tr>
<tr>
<td>Language</td>
<td>Language you'd like to view your Zendesk in. This setting only affects you.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Local time zone; used to time stamp tickets in your Zendesk. This setting only affects you.</td>
</tr>
<tr>
<td>Details</td>
<td>Additional details you'd like to add to your profile. Address, for example. Details are visible to other agents but not end-users.</td>
</tr>
<tr>
<td>Notes</td>
<td>Additional notes you'd like to add to your profile. This information is visible to other agents but not end-users.</td>
</tr>
</tbody>
</table>

To change your own user profile

1. Click your profile icon in the upper-right corner of the page header, then select View profile page.
2. Enter or update information in your profile as needed.

Your profile is automatically saved as you enter information. When you finish, you can navigate away.

**Zendesk Classic:** To change your profile in Zendesk Classic, click your name in the upper-right corner of the page header.

---

## Adding a photo to your profile

You can add a photo to your profile and it will appear in your tickets and forum posts. At any time you can change or remove your photo.

Depending on your role, you can also add photos to other users' profiles.

**To add a photo to your profile**

1. Click your profile icon in the upper-right corner of the page header, then select View profile page.

   If you want to add a photo to another user's profile, search for the user and open that user's profile instead of your own.

2. Click the profile icon in the profile, then select Upload a new photo.
To change or remove a photo in your profile

1. Click your profile icon in the upper-right corner of the page header, then select View profile page.
   If you want to change or remove a photo in another user's profile, search for the user and open that user's profile instead of your own.
2. Click the profile icon in the profile, then select Upload a new photo or Remove photo.
3. If you are uploading a new photo, select the photo.
4. Refresh the page, if necessary, to see the update.
Chapter 2

Managing your tickets

As an agent, your primary responsibility is to solve your customers' support requests. To do that, you work with tickets, which can arrive in your Zendesk in various ways such as via the Web portal request form, directly through email, by telephone and text chat, and from social media such as Twitter and Facebook. The options your customers have for requesting support are called channels. The channels that your Zendesk supports are determined by the account owner or administrator who set up your Zendesk.

Depending on how your Zendesk manages the ticket workflow, you may manually select and assign tickets to yourself or other agents. Tickets can also be automatically assigned to you and other agents via automations and triggers, which are referred to as business rules (you can read about these workflow management tools in Streamlining your support workflow in the Zendesk Administrator Guide).

This article covers the following topics:

- Viewing tickets
- Knowing when other agents are viewing a ticket
- About ticket fields
- Adding comments to tickets
- Quickly assigning yourself to a ticket
- Viewing a ticket’s events and notifications
- Asking for more information from the requester
- Asking for information from a third party
- Problem and incident tickets
- Solving a ticket and understanding how it is closed
- Managing tickets using email

Viewing tickets

All of the tickets in your Zendesk are listed in and are opened from views. Zendesk provides you with a standard set of views that organize tickets into lists based on a typical ticket workflow. For example, all of your new unassigned tickets are listed in the Unassigned tickets view.

An administrator can create new shared views (views that are visible to all agents) and edit the standard views provided by Zendesk. As an agent, you can create views for yourself so that you can organize your tickets according to your own criteria and preferences.

For detailed information about using and creating views, see Using views to manage ticket workflow.
Knowing when other agents are viewing a ticket

To help prevent more than one agent from working on a ticket at the same time, an alert is displayed in the ticket when you and someone else are simultaneously viewing a ticket. This feature is available in the Plus and Enterprise versions of Zendesk and is called *agent collision* and it looks like this in the ticket.

![Agent Collision Alert](image)

However, just because other agents may be viewing a ticket at the same time doesn't mean that they are assigned to the ticket or that they are making any changes to it. This alert is just to make you aware of who else is viewing the ticket. Any of the agents that have access to the ticket can make changes to it; therefore, it's good to know who has it open and avoid more than one agent working on a ticket at the same time.

You'll also see the agent collision message in the ticket summary pop-up that is displayed when you hover over a ticket in a view with your mouse.

**Zendesk Classic:** The ticket collision message is displayed across the top of the ticket page.

About ticket fields

Typically when an end-user submits a support request, they provide the subject and description of their question or support issue. They may also be prompted to provide additional data such as a model number or product version using custom ticket fields. All of the other data in a ticket is set by you or behind the scenes using the business rules that have been set up for your Zendesk.

Each of the standard ticket fields (referred to as *system* fields), those that are shown in the agent's view of the ticket page, are described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requester</td>
<td>All tickets require a requester. The requester is the person who made the support request. If needed, the ticket requester can be changed to someone else. See <em>Changing the ticket requester.</em> You can also create a ticket on someone else's behalf. See <em>Creating a ticket on behalf of the requester.</em></td>
</tr>
<tr>
<td>Group</td>
<td>The assignee can be set at the same time in <em>Assignee</em> field. <em>Zendesk Classic:</em> The group is set separately from the assignee. You first select a group so that an agent from that group can be set as the ticket assignee.</td>
</tr>
</tbody>
</table>
### Assignee
The assignee can be either a group or a specific agent. See *Manually assigning a ticket to yourself, another agent, or a group.*

### CC
If your Zendesk has been configured to allow it, other people can be CC’ed on tickets. Both the requester agents can add CCs to a ticket. The requester does it by adding CC email addresses if they requested support via your support email address. Agents can add CCs using the CC field when updating the ticket. See *Copying someone else (CC) on a ticket.*

### Share
The Share field is only displayed if your Zendesk has enabled ticket sharing, which means that tickets can be shared with other Zendesk accounts. See *Sharing tickets.*

### Subject
The Subject field is required. It's typically included in the support request submitted by the requester. For example, when someone submits a support request via email, the subject line of the email is used as the ticket's subject.

### Description
The description is required. This is the text of the support request. When an end-user submits a support request via email, the body of the email request is used as the description. The description becomes the first comment in the ticket.

### Status
There are five values for status: New, Open, Pending, On-hold, Solved, Closed. A ticket's status can be set and updated either manually by an agent or automatically via your business rules. A ticket's status cannot be changed to Closed manually however; that is handled automatically via your business rules.

- **New** means that the request was received but that it has not been opened and has probably not been assigned to an agent. The New status can indicate that the support team is evaluating it to determine who should be assigned to resolve it.

- **Open** means that the request has been assigned to an agent who is working to resolve it.

- **Pending** means that the assigned agent has a follow-up question for the requester. The agent may need more information about the support issue. Requests that are set to Pending typically remain that way until the requester responds and provides the information the agent needs to continue resolving the request.

- **On-hold** means that the support request is awaiting a resolution from a third party—someone who is not a member of your support staff and does not have an agent account in your Zendesk. This status is optional and must be added to your Zendesk (see *Adding the On-hold ticket status to your Zendesk* in the Zendesk Administrator Guide)

- **Solved** means that the agent has resolved the support issue. Solved tickets are closed, typically, a number of days after they have been set to Solved (the exact number of days depends on how an Administrator set this up for your Zendesk). Until a ticket is closed, the requester can reopen the ticket. For example, the requester may not agree with the agent that the support issue is resolved and reply back to the ticket solved email notification.

- **Closed** means that the ticket is complete and can't be reopened. Requesters however can create follow-up requests for closed requests.
There are four values for type: Question, Incident, Problem, and Task. You can also set the type to none, if you wish; it is not a required ticket field. Setting the type helps you to categorize your tickets, which you can then use in your workflow. For example, you can create views of tickets by their type.

**Question** is used to indicate that the requester's issue is a question rather than a problem that needs to be solved.

**Incident** is used for occurrences of a problem that affect more than one person. For example, if the wireless network in an office stops working, the problem will probably generate several support requests. Instead of handling each ticket separately, create one ticket describing the problem and set the type to Problem. Next, link the incident tickets to the problem ticket. When you solve the problem ticket, all of the linked incident tickets are solved too.

**Problem** is used to indicate that the requester is having an issue with your product or service that needs to be resolved.

**Task** is used when you want to assign the ticket as a task to a specific agent. When you select Task, you also set the Task Due Date.

There are four values for priority: Low, Normal, High, and Urgent. You can also set the type to none, if you wish; it is not a required ticket field. How you weight the priority of your tickets is up to you. For example, you might assign a ticket to Urgent based on the customer who submitted the request or based on how many hours have passed since the ticket was created.

Tags are used throughout your Zendesk to add additional information to tickets, which can then be used in your ticket workflow. Tags can be added to tickets in the following ways:

- You can add them manually.
- Tags can be added (and removed) automatically based on your business rules.
- Tags can be added to users and organizations and these tags are automatically added to tickets.

Tags are flexible and powerful tools that can be used in many ways. For more information about tags, see *Using tags* in the Zendesk Administrator Guide.

In addition to these system ticket fields, tickets can also contain custom fields, which are used to gather additional information from the person who is requesting support. For example, your Zendesk may add a custom field prompting them to select a product name or model number. Custom fields are added by administrators. For more information, see *Adding and using custom ticket fields* in the Zendesk Administrator Guide.

### Adding comments to tickets

Once a ticket has been created and it's been assigned to an agent, it's the agent's job to resolve the support request. To do that, you may need to gather more information from the requester. To communicate with the requester, you add public comments to the ticket. Public comments can be read by anyone who has access to the ticket.
Each time you add a public comment, the requester is notified via an email message. If the requester responds back to the email notification, their response is added as a public comment to the ticket. All of your communication is captured in the ticket.

You can also add private comments to tickets. These comments are only visible to other agents, not to the ticket requester or any other end-users that may have been CC'd on the ticket.

You cannot remove a comment from a ticket.

**To add a comment to a ticket**

1. Select a ticket.
2. To enter a public comment, click **Public reply** or, to enter a private comment, click **Internal note**.

**Zendesk Classic:** If you want to make a comment private, deselect the option below the comment box.

3. Enter your comment.

4. Click **Submit** to update the ticket.

You cannot delete a comment after it is added to the ticket.

It's also possible to add a note to more than one ticket at a time by bulk updating tickets. See *Bulk updating, deleting, and merging tickets*.

**Adding attachments to ticket comments**

Comments can also contain file attachments. To attach one or more files to a comment, click **Attach file**.
The maximum size of an attachment is 1 MB for Starter, 7 MB for Regular, and 20 MB for Plus and Enterprise. The files you attach to the comment are added to the email notification message.

You cannot remove an attachment from a ticket after you have submitted the ticket.

### Changing a public comment to private

After you have submitted a ticket, you can change a public comment to private. You cannot however change the first comment in a ticket. This is the ticket description and is always public.

**To make a public comment private**

1. Open the ticket that contains the comment you want to change.
2. Click the **Events** link in the comments section.
   
   **Zendesk Classic:** Click the **All events and notifications** link in the comments section.
   
   The ticket’s events and notifications are displayed.
3. Under the comment you want to change, click **Make this comment private**.

**Note:** Currently, only admins can switch public comments to private.

### Quickly assigning yourself to a ticket

When viewing a ticket in the new version of Zendesk, you can quickly assign the ticket to yourself by clicking the **Take it** link, which appears above the **Assignee** field when you hover your mouse over it, as shown here:

### Viewing a ticket’s events and notifications

Aside from the ticket field data described in *About ticket fields* above, every ticket contains comments and events and notifications. Comments are either public, meaning that the requester can see them, or private, meaning that only agents can see them.
A ticket's events and notifications capture important events in the lifecycle of the ticket and can help you more thoroughly track the updates that have occurred to the ticket and the communication that has occurred with the ticket requester.

**To view a ticket's events and notifications**

- Select a ticket and then click the Events link in the ticket header.

The ticket's events and notifications are displayed.

**Zendesk Classic:** To view events and notifications, select a ticket, then click the All events and notifications link.

### Asking for more information from the requester

Many support issues require that you gather more information from the requester so that you have enough information to resolve their issue. You add public comments to the ticket, which are sent to the requester as email notifications. When you're waiting for a requester to provide you with more information, you set the ticket Status to Pending. Doing this indicates that the ticket, from your agent perspective, is on hold.

Then, you and other agents can view all pending tickets using the Pending tickets view. Also, it's a typical best practice to set up an automation that sends the requester an email some days after you set the ticket to Pending to remind them that their input is needed before their support request can be solved. Your automations are set up by administrators.

To set a ticket to Pending, just open it and change the status and then update the ticket.

When the requester responds and a new comment is added, the ticket status is automatically reset to Open. A ticket can be changed from Open to Pending and vice versa many times during the course of resolving the support issue.

### Asking for information from a third party

If you need to get some information from a third party before you can provide the requester with a solution, you can use the On-hold status. This is an optional status and not available in your Zendesk unless an administrator has enabled it. Adding this status is described in Adding the On-hold ticket status to your Zendesk in the Zendesk Administrator Guide.

The On-hold status is similar to the Pending status in that you as an agent can't proceed with resolving the ticket until you receive more information from someone else. The On-hold status however is an internal status that the ticket requester never sees. While a ticket is set to On-hold, the requester sees the status as Open.
Problem and incident tickets

**Incident** is used for occurrences of a problem that affects more than one person. For example, if the wireless network in an office stops working, the problem will probably generate several support requests. Instead of handling each ticket separately, create one ticket describing the problem and set the type to Problem. Next, link the incident tickets to the problem ticket. When you solve the problem ticket, all of the linked incident tickets are solved too.

For more information, see the following topics:

- *Working with problem and incident tickets* in the Agent Guide
- *Streamline support using Problem and Incident tickets* in our forums

Solving a ticket and understanding how it is closed

Once you've resolved a requester's support issue, you change the ticket status to **Solved**. This should mean that you're done with the ticket and that the requester is satisfied with the resolution you provided. However, a requester can reopen the ticket after it has been set to **Solved** just by responding back and adding a new comment. For example, perhaps the requester disagrees that their support issue was resolved or that something new occurred that invalidates the fix.

After you set a ticket to **Solved**, the next status change is to **Closed**. However, you can't manually change a ticket to **Closed**; it is set to that status via a predefined business rule called an automation. An administrator creates automations and determines just how long tickets remain in the solved state before they are closed.

After a ticket's status has changed to **Closed**, the requester can no longer reopen it. They can however create a follow-up request that references the original, now closed ticket. Agents can also create a follow-up for a closed ticket. See *Creating a follow-up for a closed ticket*.

Tickets that are follow-up requests for a closed ticket are marked as such. For example:

```
Follow-up to ticket #1167 Problems using the XR60 Hypershoot
```

Closed tickets are saved indefinitely. You can view the tickets by searching for them or by creating views of closed tickets. See *Using views to manage ticket workflow*.

You can delete closed tickets if you have permissions to delete tickets. Open each ticket and select **Ticket Options > Delete** from the menu on the lower-right side of the ticket page. You can't delete closed tickets in bulk in a view. However, an administrator can use the API to delete closed tickets in bulk. See *Bulk deleting tickets* in the REST API guide.
Chapter 3

Using views to manage ticket workflow

Views define a collection of tickets based on a set of criteria that convey various ticket states such as open and unassigned, pending (awaiting response from the requester), and unsolved. Views are essential for managing the ticket workflow because they allow you to create meaningful groupings of tickets as they come in to your Zendesk and as they are managed through to resolution.

Many support teams use views to guide the workflow by requiring agents to address tickets in one view first and then others in a specific order. Views can also mirror the support structure you've created. For example, if you provide different levels of service for different customers or manage escalation using a tiered support group structure (Level 1, Level 2), you can create views for every one of these scenarios.

Zendesk provides a set of views that are essential to your day-to-day operation. These include:

- My unsolved tickets
- Unassigned tickets
- All unsolved tickets
- Recently updated tickets
- Unsolved tickets in your groups
- New tickets in your groups
- Pending tickets
- Recently solved tickets

These views can be used as is, modified, or deactivated. Only administrators can edit these standard, shared views.

You can also add views. Like macros, there are two kinds of views, shared and personal. Administrators can create shared views and agents can create their own (personal) views. Shared views can be made available to all agents or agents in a specific group.

Views, like other business rules such as triggers and automations, use conditions to define a set of tickets (you can read about these workflow management tools in Streamlining your support workflow in the Zendesk Administrator Guide). Once you’ve created a view based on conditions, you’ve got a list of tickets that meets that criteria.

Here's what a typical view looks like:
Tickets in a view are preceded with a colored icon indicating its current status. Here are the corresponding ticket statuses and colors:

- **New**: 
- **Open**: 
- **Pending**: 
- **On-hold**: 
- **Solved**: 

**Selecting views**

Select a view to see the tickets in that view.

**To select a view**

- Click the Views icon (≡) in the sidebar, then click the title of any view in the list to display tickets in that view.

**Zendesk Classic**: Click Views in the menu bar, then click the title of any view in the list.

Aside from the standard views and the views you add yourself, Zendesk may add new views when features are added. For example, enabling customer satisfaction rating adds a view. If you use SLA service targets, you'll also see those available as views.

The first 12 of your shared views and 8 of your personal views appear in the list. If you have more views, the rest of your views can be quickly accessed by clicking the More link at the bottom of the list. You can set the order of the views by reordering the views.

When viewing tickets in a view, positioning your mouse over a ticket title displays essential data about it, as shown here:
You can sort the tickets in the view by clicking any of the column headings. The view will display information based on the heading you select.

Viewing your recent tickets

To keep track of the tickets you worked on most recently, you can select to see the last five tickets that you opened or worked on.

To view your recent tickets
- Hover over the +add tab in the top toolbar.
**Zendesk Classic:** To view recent tickets, select **Recent** from the menu bar.

**Note:** The recently viewed tickets list disappears after 72 hours if there is no action taken on any of your tickets (including viewing and updating tickets).

## Viewing the next ticket in a view

When you're viewing a ticket you can easily go to the next ticket in the current view.

If you want, you can select an option to automatically open the next ticket in the view when you submit a ticket. This is an alternative to the default behavior, which is to display the current view after you submit a ticket.

**To go to the next ticket in the current view**

- From a ticket, click the **Next ticket** arrow in the upper-right corner of the ticket.

**Zendesk Classic:** Click **Next** in the upper-right corner of the ticket.

The next ticket in the current view opens, even if another agent is currently viewing it. If another agent is viewing the ticket, you will see the agent collision notification.

**Note:** If you click the **Next ticket** arrow after clicking **Start** to view tickets in a view, then the behavior is different. In that case, the **Next ticket** arrow serves the next ticket that is *not* being viewed by another agent (see *Viewing the tickets in a view*). In other words, if you are in Start mode, the Next ticket arrow shows you the next available ticket.

**To automatically go to the next ticket in the view when you submit a ticket**

- From a ticket, click the arrow on the **Submit** button and select **Go to next ticket**.
Note: This option is only available in the new version of Zendesk. It is not available in Zendesk Classic.

You do not have to select this option every time you submit a ticket. Once selected, the next ticket in the view will always open when you submit a ticket update. You can deselect this option if you prefer open the current view after you submit a ticket.

Viewing the tickets in a view

When you're looking at a view, you can select an option to start going through the tickets in the view. This option opens the first ticket in the view that is not currently being viewed by another user. Then you can use the Next ticket arrow to click through the available tickets in the view.

For example, consider you are looking at the Unassigned tickets view and you click Start. You see ticket #1 in the Unassigned tickets view, and, meanwhile, another agent is looking at ticket #2 in the Unassigned tickets view. You decide you are unable to take (assign it to yourself) ticket #1, so you want to go to another ticket in that view. From ticket #1 you can go to the next available ticket in the Unassigned tickets view. In this case you will go to ticket #3 in the Unassigned tickets view because another agent is viewing ticket #2.

Note: This option is only available in the new version of Zendesk. It is not available in Zendesk Classic.

To start viewing the tickets in a view

1. Click the Views icon (≡) in the sidebar, then select a view.
2. Click the Start button in the upper-right corner of a view.
3. The first ticket in the view that is not currently being viewed by another user opens.
4. Click the Next ticket arrow in upper-right corner of the ticket to go to the next ticket in the view that is not currently being viewed by another user.

Note: If you are not in Start mode, then the behavior of the Next ticket arrow is different. In that case, if you click the Next ticket arrow from a ticket, you see the next ticket in the current view, regardless of whether another agent is viewing (see Viewing the next ticket in a view).

Adding views

Agents can create their own (personal) views. Administrators can create personal views and shared views.

To add a view

1. Click the Manage icon (>Edit) in the sidebar, then select Views.

    Zendesk Classic: Select Manage > Views.

2. If you’re creating a personal view, select the Personal tab.

3. Click Add view.

4. Add the conditions to define this collection of tickets (see Building view condition statements below).

5. You can test the conditions by selecting Preview match for the conditions above.

6. Set the formatting options (see Setting formatting options below).

7. Set the view’s availability (see Setting a view’s availability below).

8. Click Create view.

Views can also be managed (edited, deactivated, and so on) in the Views page.

Building view condition statements

As with the other business rules, you select collections of tickets using conditions, operators, and values.

Table 1: View conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The ticket status values are:</td>
</tr>
<tr>
<td></td>
<td><strong>New</strong> is the initial status of a newly created ticket (not assigned to an agent).</td>
</tr>
<tr>
<td></td>
<td><strong>Open</strong> means that the ticket has been assigned to an agent.</td>
</tr>
<tr>
<td></td>
<td><strong>Pending</strong> indicates that the requester has been asked for information and the ticket is therefore on hold until that information is received.</td>
</tr>
<tr>
<td></td>
<td><strong>On-hold</strong> means that the support request is awaiting a resolution from a third party—someone who is not a member of your support staff and does not have an agent account in your Zendesk. This status is optional and must be added to your Zendesk (see Adding the On-hold ticket status to your Zendesk in the Zendesk Administrator Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Solved</strong> indicates that the customer’s issue has been resolved. Tickets remain solved until they are closed.</td>
</tr>
<tr>
<td>Condition</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Closed</strong></td>
<td>means that the ticket has been locked and cannot be reopened or updated. When selecting a status, you can use the field operators to specify a range of tickets based on their status. For example, a condition statement that returns only New, Open, and Pending tickets looks like this: Status is less than Solved</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The ticket type values are:</td>
</tr>
<tr>
<td><strong>Question</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Incident</strong></td>
<td>is used to indicate that there is more than one occurrence of the same problem. When this occurs, one ticket is set to Problem and the other tickets that are reporting the same problem are set to Incident and linked to the problem ticket.</td>
</tr>
<tr>
<td><strong>Problem</strong></td>
<td>is a support issue that needs to be resolved.</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td>is used by the support agents to track various tasks.</td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>There are four values for priority: <strong>Low</strong>, <strong>Normal</strong>, <strong>High</strong>, and <strong>Urgent</strong>. As with status, you can use the field operators to select tickets that span different priority settings. For example, this statement returns all tickets that are not urgent: Priority is less than Urgent</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>The group values are:</td>
</tr>
<tr>
<td><strong>(—)</strong></td>
<td>indicates that no group is assigned to the ticket.</td>
</tr>
<tr>
<td><strong>(current user's groups)</strong></td>
<td>is all the groups to which the agent who is updating the ticket belongs.</td>
</tr>
<tr>
<td><strong>(assigned group)</strong></td>
<td>is the group that is assigned to the ticket.</td>
</tr>
<tr>
<td><strong>Group name</strong></td>
<td>is the actual name of the group that is assigned to the ticket.</td>
</tr>
<tr>
<td><strong>Assignee</strong></td>
<td>The assignee values are:</td>
</tr>
<tr>
<td><strong>(current user)</strong></td>
<td>is the last person to have updated the ticket, which is not necessarily the same person who is assigned to the ticket. The current user (whoever updated the ticket last) changes whenever the ticket is updated. And an update may have been made by the assignee, the requester, or someone who was CC’d on the ticket.</td>
</tr>
<tr>
<td><strong>(requester)</strong></td>
<td>is the ticket requestor. You can select this option to return tickets that were opened by and then assigned to the same agent, for example.</td>
</tr>
<tr>
<td><strong>(assignee)</strong></td>
<td>is the person who is assigned to the ticket.</td>
</tr>
<tr>
<td><strong>Agent name</strong></td>
<td>is the actual name of the person assigned to the ticket.</td>
</tr>
<tr>
<td><strong>Requester</strong></td>
<td>The requester values are:</td>
</tr>
<tr>
<td><strong>(current user)</strong></td>
<td>is the last person to have updated the ticket.</td>
</tr>
<tr>
<td><strong>(requester)</strong></td>
<td>is the ticket requestor.</td>
</tr>
<tr>
<td>Condition</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>(assignee)</strong></td>
<td>is the person assigned to the ticket. The condition statement “Requester is Assignee” is true if the requester is also the person assigned to the ticket. This is possible if an agent created a ticket and was then assigned to it.</td>
</tr>
<tr>
<td><strong>Agent name</strong></td>
<td>is the actual name of the agent.</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>The organization values are:</td>
</tr>
<tr>
<td>(—)</td>
<td>is used to indicate that no organization has been added to the ticket.</td>
</tr>
<tr>
<td><strong>Organization name</strong></td>
<td>is the name of an organization.</td>
</tr>
<tr>
<td><strong>Tags</strong></td>
<td>You use this condition to determine if tickets contain a specific tag or tags. You can include or exclude tags in the condition statement by using the operators Contains at least one of the following or Contains none of the following. More than one tag can be entered. They must be separated with a space.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The description is the first comment in the ticket.</td>
</tr>
<tr>
<td><strong>Ticket channel</strong></td>
<td>The ticket channel is where and how the ticket was created and can be any of the following:</td>
</tr>
<tr>
<td></td>
<td>• Web form</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Twitter</td>
</tr>
<tr>
<td></td>
<td>• Twitter DM (direct message)</td>
</tr>
<tr>
<td></td>
<td>• Twitter Favorite</td>
</tr>
<tr>
<td></td>
<td>• Voicemail</td>
</tr>
<tr>
<td></td>
<td>• Phone call (incoming)</td>
</tr>
<tr>
<td></td>
<td>• Get Satisfaction</td>
</tr>
<tr>
<td></td>
<td>• Feedback Tab</td>
</tr>
<tr>
<td></td>
<td>• Web service (API)</td>
</tr>
<tr>
<td></td>
<td>• Trigger or automation</td>
</tr>
<tr>
<td></td>
<td>• Forum topic</td>
</tr>
<tr>
<td></td>
<td>• Closed ticket</td>
</tr>
<tr>
<td></td>
<td>• Ticket sharing</td>
</tr>
<tr>
<td><strong>Ticket received at...</strong></td>
<td>This condition checks the email address from which the ticket was received. The ticket can be received from a Zendesk email domain such as <a href="mailto:sales@mondocam.zendesk.com">sales@mondocam.zendesk.com</a>, or from an external email domain such as <a href="mailto:support@acmejetengines.com">support@acmejetengines.com</a>.</td>
</tr>
<tr>
<td><strong>Requester's language</strong></td>
<td>Returns the language preference of the person who submitted the request.</td>
</tr>
<tr>
<td><strong>Ticket Satisfaction</strong></td>
<td>This condition returns the following customer satisfaction rating values:</td>
</tr>
<tr>
<td></td>
<td>• Unoffered means that the survey has not previously been sent</td>
</tr>
<tr>
<td></td>
<td>• Offered means that the survey has already been sent</td>
</tr>
<tr>
<td>Condition</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bad</td>
<td>means that the ticket has received a negative rating</td>
</tr>
<tr>
<td>Good</td>
<td>means that the ticket has received a positive rating</td>
</tr>
</tbody>
</table>

**Hours since...**

This condition allows you to select tickets based on the hours that have passed since the ticket was updated in the following ways:

- Hours since created
- Hours since opened
- Hours since pending
- Hours since on-hold
- Hours since solved
- Hours since closed
- Hours since assigned
- Hours since update
- Hours since requester update
- Hours since assignee update
- Hours since due date (for tickets with the type set to Task)
- Hours until due date (for tickets with the type set to Task)

**Custom fields**

Custom fields that set tags (drop-down list and checkbox) are available as conditions. You can select the drop-down list values and Yes or No for checkboxes.

---

**Setting formatting options**

You can decide what ticket data you want displayed in a view, how the tickets are grouped and ordered, and how many tickets are shown per page. There is a **List** style view and a **Table** style view. The **List** view, however, is not available in the new version of Zendesk (it's only available in Zendesk Classic). The Table view offers more formatting options and greater customization.

**To select the ticket data you want included in the view**

1. Select the **Table** formatting option.
2. Drag the table columns you want included and drop them into **Columns included in table**.
To set the order of a view
- Select the ticket data field you want used as the default data to order the tickets in the view. You can select Ascending or Descending.

To set the grouping of tickets in a view
- Select the ticket data field you want to group the tickets in the view. You can select Ascending or Descending.

To set the number of tickets per page (Zendesk Classic only)
- You can select either 15 or 30 tickets to display per page in Zendesk Classic. This setting has no affect in the agent interface in new Zendesk.

Setting the view's availability (administrators only)
When an administrator creates a view, they have the option of setting who can access the view. There are two types of shared views: all agents and only those agents in a specific group. Like
agents, administrators can create personal views as well. When creating or editing a view, an administrator sets access to the view with one of the following options:

<table>
<thead>
<tr>
<th>Available for</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All agents</td>
<td></td>
</tr>
<tr>
<td>Agents in group</td>
<td>Billing</td>
</tr>
<tr>
<td>Me only</td>
<td></td>
</tr>
</tbody>
</table>

Editing and cloning views

You can edit and clone views. Cloning a view creates a copy that you can modify and use for some other purpose.

To edit a view

1. Click the Views icon (≡) in the sidebar, then select a view.
2. Click the down arrow next to the title of the view.
3. Click Edit. The View edit page is displayed and you can modify the view as needed.

To edit a view (Zendesk Classic)

1. Select Manage > Views.
2. If you're editing a personal view, select the Personal tab.
3. Locate the view you want to edit and select Edit.
4. Modify the title and conditions as needed.
5. Select Update, then click Submit.

Zendesk Classic: Click Update View.

To clone a view

1. Click the Views icon (≡) in the sidebar, then select a view.
2. Click the down arrow next to the title of the view.
3. Click **Clone**. A copy of the view is displayed in the View edit page and you can modify the cloned view as needed.

**To clone a view (Zendesk Classic)**

1. Select **Manage > Views**.
2. If you're cloning a personal view, select the **Personal** tab.
3. Locate the view you want to clone and select **Clone**. This command appears when you move your mouse over the view in the list of views.
4. Enter a new name for your view and modify the conditions as needed.
5. Click **Create View**.

### Reordering views

You can reorder your list of views, which affects what you see in the **Views** tab in the menu bar. Agents can only reorder their personal views. Administrators can reorder their own views and all shared views.

**To reorder the list of views**

1. Click the **Manage** icon (ображення) in the sidebar, then select **Views**.
   
   **Zendesk Classic:** Select **Manage > Views**.
2. If you're reordering personal views, select the **Personal** tab.
3. Click **Reorder** at the end of the list of active views.
4. Click and drag views to new locations.
5. Click **Done** when you are finished.

### Deleting and deactivating views

If you decide that you no longer need a view you can either delete it or deactivate it. Deleting it of course means that it's gone and can't be retrieved. You can instead deactivate views. Deactivated views are listed in a separate table on the **Views** page and can be reactivated if needed.

**To delete a view**

1. Click the **Manage** icon (ображення) in the sidebar, then select **Views**.
   
   **Zendesk Classic:** Select **Manage > Views**.
2. If you're deleting a personal view, select the **Personal** tab.
3. Locate the view you want to delete and select **Edit**.
4. Click **Delete**.

**To deactivate/activate a view**

1. Click the **Manage** icon (ображення) in the sidebar, then select **Views**.
   
   **Zendesk Classic:** Select **Manage > Views**.
2. If you're deactivating a personal view, select the **Personal** tab.
3. Locate the view you want to deactivate and select **Deactivate**. This command appears when you move your mouse over the view in the list of views.
4. Click **OK** to confirm that you want to deactivate the view. The view is deactivated and displayed in the list of inactive views.
5. To reactivate the view, select it from the list of inactive views and select **Activate**.

### Exporting a view to a CSV file

You can export a view to a CSV (comma separated values) file. The CSV file will contain an entry for each ticket and all its associated ticket information in the view.

**To export a view to a CSV file**

1. Click the **Views** icon (≡) in the sidebar, then select a view.
2. Click the down arrow next to the title of the view.
3. Click **Export as CSV**.

You will receive an email notification (sent to your primary email account in your user profile) that contains a download link for your CSV file.

**To export a view to a CSV file (Zendesk Classic)**

1. Select a view by clicking **Views** in the menu bar.
2. Click the title of the view you want to export to CSV.
3. Click the **CSV** link in the upper-right corner of the view.

The CSV file opens.
Chapter 4

Manually assigning a ticket to yourself, another agent, or a group

Depending upon how your Zendesk manages incoming support requests, tickets may be automatically assigned to you, to other agents, and to groups. If you manually evaluate and assign tickets, then assigning yourself, another agent, or a group to a ticket is as simple as selecting the ticket assignee.

To manually assign a ticket to a group or another agent

1. Open a ticket from one of your views.
2. You can assign the ticket to a group or to an agent and a group. When you click the Assignee field, all of your groups are listed.

3. You can either scroll the list and select the group and then the agent or you can just enter the group or agent's name to filter the list. For example, to find an agent named Steven, enter that name and you'll see the following:
Zendesk Classic: Select a group from the Group field drop-down list. Choose the appropriate group and the list of agents included in that group will be available in the Assignee field.

4. Select a group or another agent as the Assignee.
5. Click Submit to update the ticket.

To manually assign a ticket to yourself

1. Open a ticket from one your views.
2. Click Take it above the Assignee field.

Note: This option is only available in the new version of Zendesk, not Zendesk Classic.

3. Click Submit to update the ticket.

You can change a ticket assignee at any time.

You can also bulk assign tickets using a view. For example, you can open a view, pick and choose the tickets you want to assign to a single group or agent, and then assign all the tickets in a single step. See Bulk updating, deleting, and merging tickets.
If your Zendesk is configured to allow it, you can copy (CC) people on tickets. You might do this if you want someone else to be aware of the ticket or provide some feedback about it. You can only add users as a CC on a ticket if they have an account in your Zendesk.

You can CC both agents and end-users. CC recipients are notified when a ticket update contains a comment. Agents are notified whenever new public and private comments are added to the ticket. End-users are only notified about (and can only see) public comments that have been added.

A CC recipient is not copied if any of the following conditions applies:

- the CC recipient added the comment
- the ticket is updated without a comment
- the CC recipient will get a trigger notification too
- the CC recipient is listed on the “To” line of the email that generated the comment (or in the case of a new ticket, the email that created the ticket)

You can add up to 24 end-users as CCs on a ticket. Additionally, you can add an unlimited number of agents.

**Note:** It is not possible to add a blind CC (BCC). Also, you cannot CC the ticket requester.

**To add a CC to a ticket**

1. Select a ticket from one of your views.
   
   The CCs field is displayed in the ticket properties panel.

   **Zendesk Classic:** Click Edit/Share next to the ticket requester's name to display the CC field.

2. Begin entering a user's name and the relevant results are displayed.

   ![Ticket properties panel with CC field]

   You can quickly add yourself as a CC by clicking cc me above the CCs field.

   **Note:** This option is only available in the new version of Zendesk, not Zendesk Classic.
3. If you want to CC a user that doesn't have an account in your Zendesk, enter the person's email address in the CC field and press the spacebar. An end-user is created with the information in the email address. For example, entering dave@un-scripted.com creates a user named "dave" with the email address dave@un-scripted.com. You don't need to enter any other information about them yet.

You can also add them as new users first. Hover over the +add tab in the top toolbar, then select User and follow the steps described in Adding end-users. Unless the admin has changed the default setting, new users receive the welcome email and need to verify their account before they can view the ticket.

4. Select the user. The changes you make to ticket properties are saved immediately.

**To remove a CC from a ticket**

- Click the delete button (X) in the person's name box in the CC list.
Chapter 6

Deleting tickets

Some support teams never delete tickets; they instead move them through their workflow to close them using an automation. You can however delete a ticket if you want. When you do, it is immediately deleted and cannot be recovered.

Zendesk Classic: The following procedure is not applicable to Zendesk Classic. To delete a ticket in Classic, select the ticket update option Delete ticket. Click OK in the warning, then click Submit.

To delete a ticket

1. Open the ticket that you want to delete.
2. Click Ticket options in the bottom toolbar, then select Delete.
3. You'll be warned that the ticket will be permanently deleted.
4. Click OK and the ticket is immediately deleted.

Deleting more than one ticket at a time

You can use a view to delete more than one ticket in a single step. See Bulk updating, deleting, and merging tickets.
Merging tickets

If needed, you can merge one or more tickets into another ticket. You might do this if you receive two support requests about the same issue from the same end-user, for example.

Be sure that you merge the correct tickets. Ticket merges are final; you cannot undo or revert a ticket merge.

You cannot merge a ticket with a ticket that's shared, or with one that's already closed.

To merge one ticket into another ticket

1. Open the ticket that you want to merge into another ticket.
2. Click Ticket options in the bottom toolbar, then select Merge into another ticket.

Zendesk Classic: Select the ticket update option Merge into another ticket and then click Submit.

3. You can enter a ticket number, select one of the ticket requester's open tickets, or select one of your recently viewed tickets.
4. When you select a ticket to merge into, you'll be prompted to confirm the merge. You can also edit the merge comments that are added to each ticket and also set whether or not the comments will be public or private using the **Requester can see this comment** option.
5. Select **Confirm and Merge**.

Be sure that you merge the correct tickets. Ticket merges are final; you cannot undo or revert a ticket merge.

The ticket that was merged into another ticket is closed.

It's also possible to merge a group of tickets into a single ticket. See *Bulk updating, deleting, and merging tickets*.
Chapter 8

Creating a ticket on behalf of the requester

There may be times when you need to open a ticket on someone else's behalf. For example, you may be providing support to someone using a telephone (and not Zendesk Voice, which creates a ticket for you when you take the call) and you want to capture the support request in a ticket. You can create a new ticket and then set the person you're providing support to as the ticket requester.

To create a ticket on the requester's behalf

1. Hover over the +add tab in the top toolbar, then select Ticket.

   + add
   
   New...

   Ticket
   
   User
   
   Organization

   Recently viewed tickets...

   #3414 Re: When will a Mondo camera include GPS?
   Anton de Young

Zendesk Classic: Select New from the top menu bar.

2. If the requester is an existing user, begin entering the user's name in the Requester field and the relevant results are displayed. Select a user.

   Note: Alternatively, you can open the user's profile, then click User options in the bottom toolbar and select New ticket. The user's name automatically appears in the Requester field.

   If the requester does not yet have an account, add them by hovering over the +add tab in the top toolbar, then selecting User. After you add the new user, return to the ticket and enter their name in the Requester field.

3. Enter the ticket data, then click Submit as New.

   The requester receives the new ticket email notification and the ticket indicates that it was created by you for the requester, as shown here:
Anton de Young  MondoCAM (on behalf of Siena Nenners)

Siena needs a replacement CD for the software that comes with the ZD-89.
Chapter 9

Changing the ticket requester

It's possible to change an existing ticket's requester to someone else. You may want to do this if someone sent in a support request on someone else's behalf. The user who you want to set as the requester must be a user in your Zendesk.

**Note:** You can’t change the requester on a ticket that has been *shared* or closed.

**To change the ticket requester**

1. Select a ticket from one of your views.
2. Next to the ticket requester's name, below the ticket title, click *Change*.

**Zendesk Classic:** Click *Edit/Share* next to the ticket requester's name, then click *Change*.

The Requester field is displayed in the ticket properties panel.

3. Begin entering a user's name and the relevant results are displayed. Select the user.
4. Click *Submit* to save the ticket update.

After you've changed a requester, you can later see who the original requester was by checking the ticket's events and notifications.
Chapter 10

Creating a follow-up for a closed ticket

Once a ticket is closed, it cannot be reopened. However, both the requester and you can create a follow-up request. This creates a new ticket that references the closed ticket and also pulls all of the original ticket data into the new ticket.

You can create a follow-up by using the steps described below. The requester can create a follow-up by accessing the ticket when logged into the Web portal and following a similar procedure.

To create a follow-up for a closed ticket

1. Locate the closed ticket that you want to create a follow-up for. You can do this by locating the requester first and then selecting one of their closed tickets, by searching for the ticket number, or by creating a view for closed tickets and locating the ticket there.
2. When you view a closed ticket, you'll see the option to create a follow-up ticket.
3. Click Create follow-up.

A new ticket is created that contains the same data as the original ticket.
4. Update the ticket data as needed and then click Submit to save the new ticket. The requester will receive an email notification for the new ticket. The new ticket is marked as a follow-up, as shown here:
Chapter 11

Working with problem and incident tickets

Problem-and-incident tickets are useful when a problem or service interruption is reported by more than one person. For example, when the wireless network in an office stops working, several people might file support tickets. You can treat the tickets as incident reports. Instead of handling each ticket separately, you can link the tickets to one problem ticket, and then solve the problem ticket to solve all the incident tickets.

Here’s the general workflow:

1. Identify a service interruption or problem that’s causing people to file tickets.
2. Create your own ticket to address the problem.
3. Change the other tickets to incident tickets and link them to your problem ticket.
4. Solve the problem ticket.

When you solve the problem ticket, the status of all the incident tickets is automatically set to solved.

To create problem-and-incident tickets

1. After identifying a problem that’s causing people to file tickets, create your own ticket describing the problem and set the ticket type to Problem.
2. For every other ticket reporting the same problem, set the ticket type to **Incident** and link it to the problem ticket.

   After you set the type to Incident, a second menu appears that lets you link the incident to a problem ticket.

   Make sure to click **Update** to save the changes to the ticket.

3. Solve the problem ticket.

   The problem ticket has a link to a view of linked tickets so you can review the incident reports.
Solving the problem ticket solves all the incident tickets linked to it. Any comment you make in the problem ticket is included in all the linked incident tickets.

**Tip:** Use dynamic content placeholders to personalize the comment for wide distribution. Example:

![Example comment](image)

For instructions, see *Using placeholders*.

**Related topics**

- *Streamline support using Problem and Incident tickets*
Chapter 12

Sharing tickets

If your Zendesk has enabled ticket sharing, you can share tickets with other Zendesk accounts. This allows you to collaborate with other support teams to solve your customer's support requests. For example, imagine that you sell a product that is produced by a different company. If you both use Zendesk to provide support to your customers, you can share a ticket to that other company who can then help to resolve the support issue.

For a detailed explanation of how ticket sharing works, see *Sharing tickets with other Zendesk accounts* in the Zendesk Administrator Guide. Setting up ticket sharing is done by an administrator. As an agent you can share tickets with other Zendesk accounts.

To share a ticket

1. Open the ticket that you want to share.
2. In the ticket properties panel, click **Share ticket with** and then make a selection from the list.

   **Zendesk Classic**: Click **Edit/Share** next to the requester's name below the ticket ID, then make a selection from the **Share ticket** list.

3. Update the ticket by clicking **Submit**.

When the ticket has been shared, it is indicated in the ticket below the ticket title as shown here:

Outbound indicates that you shared the ticket to another Zendesk account. If the ticket had been share to your Zendesk, it would be marked as an inbound ticket.

Depending on the permissions defined in the sharing agreement, the ticket status and comments may remain synced. The ticket's events and notifications indicate when a ticket update occurred due to ticket sharing.

Unsharing tickets

You can unshare a ticket that you've shared. Doing so means that the previously shared ticket will become an 'orphan' in the receiver's Zendesk. In other words, unsharing doesn't automatically remove the ticket from the receiver's Zendesk. Rather, the receiving Zendesk needs to manage the orphaned ticket out of their queue using their own business rules.
To unshare a ticket

1. Open the ticket that you want to unshare.
2. In the ticket properties panel, click Share ticket with and then select Unshare.

3. Update the ticket by clicking Submit.

**Zendesk Classic:** To unshare a ticket in Zendesk Classic, in the shared ticket, click Edit/Share next to the requester's name. Select the Unshare ticket action and click Submit.
Chapter 13

Bulk updating, deleting, and merging tickets

Using your views, you can make ticket updates to many tickets at the same time. For example, if you want to assign yourself to a number of tickets, you just select them in a view and then set yourself as the assignee. You can also apply macros to, delete, or merge the selected tickets.

Topics covered in this article:

- Bulk updating tickets
- Bulk deleting tickets
- Bulk merging tickets

Bulk updating tickets

The maximum number of tickets you can update at one time is 99 tickets.

To update multiple tickets in a view

1. Open one of your views and select the tickets you want to update.
   
   You can pick and choose the tickets you want to update or select the entire list by clicking the Select All box.

   Zendesk Classic: Make sure you're in the table view of the list of tickets.

2. Click Edit tickets.

   Zendesk Classic: There isn't an Edit tickets button; simply scroll down to the Update selected tickets section after you select your tickets.

3. In Update tickets you can update ticket properties for all of the tickets you selected.

   You can also apply a macro to all the tickets by selecting it from the Apply Macro menu. If you want to cancel the bulk update, click the X in the upper-right corner.
4. Click Submit to save your ticket updates.

Bulk deleting tickets

Using your views, you can delete multiple tickets at the same time. Once deleted, tickets cannot be recovered, so be sure that you select the right tickets.

To give your agents permission to delete tickets, click the Manage icon (.Mapper) in the sidebar and select Agents in the Settings category. Next, select the Agents Can Delete Tickets option and click Save. If you're on the Enterprise plan, you can allow only certain agents to delete tickets based on the agents' roles. For more information, see Custom agent roles in the Administrator Guide.

Note: You cannot bulk delete closed tickets.

To delete multiple tickets in a view

1. Open one of your views and select the tickets you want to delete.
   
   You can pick and choose the tickets you want to delete or select the entire list by clicking the Select All box.

2. Click Edit tickets.

    Zendesk Classic: There isn't an Edit tickets button; simply scroll down to the Update selected tickets section after you select your tickets.

3. In Update tickets, click Ticket options in the bottom toolbar, then select Delete.
Zendesk Classic: Select the ticket update option Delete selected tickets, then click Submit.

4. When prompted, click Yes to confirm that you want to delete the tickets.

You will not be able to recover the tickets after you confirm the deletion. The tickets are permanently deleted.

Bulk merging tickets

Merging one ticket into another ticket is described in Merging tickets.

You can also select tickets in a view and merge one or more tickets into another ticket. Be sure that you merge the correct tickets. Ticket merges are final; you cannot undo or revert a ticket merge.

You cannot merge tickets with a ticket that's shared, or with one that's already closed.

To merge multiple tickets in a view into another ticket

1. Open one of your views and select the tickets you want to merge.

You can pick and choose the tickets you want to merge or select the entire list by clicking the Select All box.

2. Click Edit tickets.

Zendesk Classic: There isn't an Edit tickets button; simply scroll down to the Update selected tickets section after you select your tickets.

3. In Update tickets, click Ticket options in the bottom toolbar, then select Merge tickets into another ticket.

Tip: Be sure to have the ticket number of the ticket you want to merge into handy before you start the merge process.

Zendesk Classic: Select the ticket update option Merge into another ticket.

4. In the Merge ticket dialog, enter the ticket number for the ticket you'd like to merge the selected tickets into, then click Merge. Alternatively, you can select a recently viewed ticket.
5. When prompted, click **Confirm and Merge** to confirm the merge. If you want to cancel the merge, click **Close** instead.

Be sure that you merge the correct tickets. Ticket merges are final; you cannot undo or revert a ticket merge.
Chapter 14

Viewing, recovering, and deleting suspended tickets

Some of the email that comes into your Zendesk may be flagged as spam and be either completely rejected or sent to the suspended tickets queue where they may be permanently deleted or recovered. The reasons why email is rejected or suspended is described in Managing suspended tickets and spam in the Zendesk Administrator Guide.

As an agent, you can view and either delete or recover suspended tickets. All unrecovered suspended tickets are automatically deleted after 14 days.

Viewing suspended tickets

Suspended tickets appear in a system-generated view. If you have no suspended tickets, you will not see a view. If you do, the Suspended tickets view is added to your list of views, as shown here:

Selecting the view allows you to manage the suspended tickets. You can view detailed information for each, including the reason for suspension, and then recover or delete them.

Recovering or deleting suspended tickets

Tickets that have been suspended can be manually unsuspended and placed back into your ticket queue. You can unsuspend tickets in the Suspended Ticket view one at a time or in bulk. You can also delete suspended tickets.
To bulk recover or delete suspended tickets

1. Select the Suspended tickets view.
2. Select the tickets you want to recover or delete. You can select all the tickets in the view by clicking the selection check box in the table header.

<table>
<thead>
<tr>
<th>ID</th>
<th>SUBJECT</th>
<th>REQUESTED</th>
<th>SUSPENSION TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>#125088077</td>
<td>Make your life better in 30 steps</td>
<td>Oct 26</td>
<td>Detected as spam</td>
</tr>
<tr>
<td>#124036042</td>
<td>Ecco come dimagrire</td>
<td>Oct 26</td>
<td>Detected as spam</td>
</tr>
<tr>
<td>#127219926</td>
<td>Make your life better in 30 steps</td>
<td>Oct 26</td>
<td>Detected as spam</td>
</tr>
<tr>
<td>#125113087</td>
<td>O MELHOR PARA VOCE OJ PARA SUA EMPR...</td>
<td>Oct 26</td>
<td>Detected as spam</td>
</tr>
<tr>
<td>#127703351</td>
<td>FABRICA DE MUEBLES A MEDIDA</td>
<td>Oct 28</td>
<td>Detected as spam</td>
</tr>
</tbody>
</table>

3. Select and then click either Recover or Delete option in the submit button.

Zendesk Classic: When bulk recovering or deleting tickets in Zendesk Classic, you'll see these options:

- Detected as spam
- Automated response mail
- Automated response mail, out of office
- a.com

The tickets you recover will be shown in your Unassigned tickets view. Deleted tickets cannot be recovered, they are permanently deleted.

To recover or delete a single ticket

1. Select the Suspended tickets view.
2. Click the Subject of the ticket you want to recover or delete.
3. You can select to Delete, Recover Manually, or Recover Automatically. The automatic recover option immediately recovers the ticket. The manual recover option allows you to edit the ticket properties first and then recover the ticket.

**Zendesk Classic:** When you select a single suspended ticket, you have the following delete and recover options:

![Delete, Recover Options](image)

When you recover a suspended ticket for a new user (not a known user in your Zendesk account), an unverified new user account is created.
Chapter 15

Formatting ticket comments with Markdown

You can add rich text comments to your ticket comments, your macros, and your agent signature. This is possible when an administrator enables Markdown in your Zendesk account (see Enabling Markdown in the Zendesk Administrator Guide). Markdown is a simple markup language that enables you to add text formatting such as bold and italic, bullet lists, headings and so on to your ticket comments.

Markdown renders as HTML in preview mode and in your email notifications.

You edit your comments in Write mode and then click into Preview mode to see the results.
Zendesk Classic: The **Write** and **Preview** buttons are located on the left side of the comment:

---

Markdown is used in many web technologies and programming languages, so you may already be familiar with it. The complete Markdown reference is available here: [Markdown syntax documentation](#). We’ve included some examples of the formatting you can do with Markdown, but it is by no means exhaustive. You should consult the Markdown reference for more information.

**Markdown examples**

Markdown can be used by agents in ticket comments, in macros, and in your agent signature. You add Markdown formatting as plain text and can then preview it before saving the comment (via submitting a ticket update).
Bold and italic

The asterisk character (*) is used for both italic and bold emphasis.

*I will display in italics*

**While I will display in bold**

You also use the underscore (_) character.

_ I will display in italics_

__While I will display in bold__

Lists

You can create both ordered and unordered lists. Lists must begin and end with a blank line.

Unordered lists can begin with either an asterisk or a plus or minus sign, followed by a space.

* Item 1
* Item 2
* Item 3

+ Item 1
+ Item 2
+ Item 3

- Item 1
- Item 2
- Item 3

Each option (asterisk, plus, or minus sign) renders as an `<ul>` tag in HTML:

```html
<ul>
  <li>Item 1</li>
  <li>Item 2</li>
  <li>Item 3</li>
</ul>
```

You create numbered lists using a number and a period followed by a space. The numbers you use are unimportant because any combination will render as a `<ol>` tag and properly number the items in the list. So, either of these examples will work:

1. Item 1
3. Item 2
100. Item 3

1. Item 1
1. Item 2
1. Item 3

You can nest lists by adding two spaces at the beginning of the list items. You can only nest lists one level down.

* Level 1
  * Level 1
  * Level 2
Block quotes

Quotes are created using the right arrow character (>) and a space, which you add before each line of the quote. The quote must begin and end with a blank line. How you break the quote into separate lines is up to you.

> Quoting people is easy, you simply put a
> before each line
> of the text you want to quote

Inline code and code blocks

To format code inline, you use the following:

```
'codeIsAwesome()'
```

Code blocks are formatted like this:

```
...
Code blocks
    are great for display
    large amount of code
        that need to maintain whitespace
    and indenting
```

A code block must begin and end with a blank line. Within the code block itself, you use spaces to indent your lines of code.

Images and links

To add images, you link to images to you have hosted somewhere on the internet using this formatting:

![I am an image's alt text](http://www.example.com/image.png)

The alt text is not required, so you can also do this:

![](http://www.example.com/image.png)

Links use a similar syntax, but the exclamation point (!) is not used. The link text is contained in brackets and the link itself in parenthesis.

[I am the text to be linked](http://www.example.com)

**Note:** We still auto link URLs, so there's no need to write something like this:

[http://www.example.com](http://www.example.com)
Headings

Heading levels are expressed using the hash character (#) followed by a space.

```
# Heading 1
## Heading 2
### Heading 3
#### Heading 4
##### Heading 5
###### Heading 6
```

You must add blank lines above and below each heading.

```
# Heading 1
```

Adding an image to your agent signature

Here's an example of how you can use Markdown in your agent signature (in your user profile). If you wanted to add your company's logo, use this Markdown formatting:

```
Charles Nadeau
Support Agent
**MondoCam Customer Support**
![MondoCam logo](http://mondocam.com/assets/logo.png)
```

This example formats the company name as bold and then embeds the company logo. This will be rendered in the ticket comment and in the email notification when you submit a ticket update.

This Markdown can also be used in the global signature. This is the signature that is set for your entire Zendesk (Settings > Agents > Signature).

Adding Markdown to macros

You can add Markdown to the Comment/description action in a macro just as you would when entering Markdown directly into a ticket comment. When you apply the macro, you'll see the Markdown text formatting while in Write mode and then you can see it rendered as HTML by switching to Preview mode.
End-users are those people who request support; these are your customers. They may interact with your Zendesk using the Web portal, via email or chat or telephone, and also through popular social media such as Facebook and Twitter. All of these paths into your Zendesk are referred to as channels.

Regardless of the channel that your customers use to request support, each customer must have an account in your Zendesk. And, like channels, there are many ways that users can be added. They can add themselves simply by submitting a support request. You can add them manually or in a bulk import of users. Users can also be added via the Zendesk API.

As an agent, you can add end-users by creating new user accounts. You might do this, for example, if you’re on the telephone with a customer who has never before requested support and therefore does not yet have a user account. By adding them to your Zendesk, you can open a ticket for the customer and they will then receive email notifications whenever the ticket is updated and be able to communicate via email with the agent assigned to the ticket.

You can allow end-users access to the Web portal so that they can sign in and submit and track support requests. Or you might only interact with their end-users via email, never providing them with access to the Web portal. To sign in to the Web portal, end-users need to verify their account and create a password. End-users who only interact with your Zendesk via email are not required to verify their account since they do not sign in to the Web portal.

So, depending on how your Zendesk is set up, when you add a new end-user they may or may not receive an email prompting them to verify their account and create a password. However, everyone who requests support receives an email when a ticket is created that acknowledges that their request has been received and is being worked on.

An end-user’s account contains required data such as their name and email address. It can also contain additional identities, such as other email addresses, the user’s Twitter handle, their organization, and the rest of the data described in the following section.

Adding end-users

To add an end-user to your Zendesk, follow the steps below. As an agent, you can only add end-users. Administrators can add other administrators, agents, and end-users.

Administrators can also add users in a bulk import. See Bulk importing users and organizations in the Zendesk Administrator Guide.
Zendesk Classic: The following procedure is not applicable to Zendesk Classic. To add a user in Classic, select Manage > People, then click Add user. Enter the user's information (refer to the table below), then click Create.

To add an end-user

1. Hover over the +add tab in the top toolbar, then select User.

2. Enter the user's full name and email address.
3. Click Save.

   You can add additional information to the user's profile after clicking Save.

4. When the user's profile opens, enter the user's information (described below).
5. If you want to add additional contact info, click Add contact, select the type of contact, then enter the contact info in the field that appears. Repeat as needed.
6. When you are finished entering information, you can close the user's profile by navigating away from it.

<table>
<thead>
<tr>
<th>User data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>Defines the user's function and access level in your Zendesk. There are three user types: End-user, Agent, Administrator. By default, all new users are set to end-users. Agents can only add end-users. Only administrators can change a user's role.</td>
</tr>
<tr>
<td>Access</td>
<td>Enable the end-user to access only the tickets they create or give them access to all tickets created by users in their organization.</td>
</tr>
<tr>
<td>Email</td>
<td>This is the email address you added in the first step above.</td>
</tr>
<tr>
<td>Contacts</td>
<td>You can also add additional contact information for users using the Add contacts link. See Adding and managing user contact information below.</td>
</tr>
<tr>
<td>Tags</td>
<td>Add any tags you want automatically added to new tickets created by the end-user. Separate tags with a space. Tags are added to new tickets only, not updated tickets. This is an optional feature and your Zendesk may not have</td>
</tr>
</tbody>
</table>
### Adding user contact information

A user account can contain multiple types of contact information, including email, Google, Twitter, Facebook, and phone.

A user account can contain multiple email addresses. Each time you add an email address, a verification email is sent to that address and must be confirmed before the email address is valid. One email address is set as the primary, which means that notifications are sent to that address. You can change the primary email address to any of the other verified email addresses.

**Note:** In addition to adding contact info to a user profile, you can add a photo to a user's profile, depending on your role. For more information, see [Adding a photo to your profile](#).

#### To add contact information for an end-user

1. Click the **Search** icon (🔍) in the sidebar, then enter a name in the search box and click the user's name when it appears.

   **Zendesk Classic:** Enter a name in the search box in the top toolbar, then, when the user's name appears, click the **Edit** link next to the name.

2. In the user's profile, click **Add contact** and select the type of contact you want to add, then enter the contact information in the field that appears.

   **Zendesk Classic:** Add a phone number in the **Basic Info** tab. In the **Identities** tab, click the **Add** link in the **Email** or **External accounts** sections to add an email address or a Twitter account.

3. Repeat as needed.

4. When you are finished, you can close the user's profile by navigating away from it.

#### To remove a contact, other than phone number

- In the user's profile, click the contact info you want to delete and select **Remove**.
To change or remove a phone number

- In the user's profile, click in the phone number field and enter the new phone number or delete all the digits to remove it.

**Zendesk Classic:** In the **Basic Info** tab of the user's profile, click in the phone number field and enter the new phone number or delete all the digits to remove it.

To make an email primary, to resend verification, or to verify an email

- In the user's profile, click the email address and select the appropriate action.

**Zendesk Classic:** In the **Identities** tab of the user's profile, select another email addresses as primary. The email address you choose must have been verified.

**Viewing and editing a user's profile**

Your registered end-users can edit their own profiles when they sign in to your Web portal. They can't change their role or organization but they can update their contact information, add a photo, and so on.

Agents and administrators can also edit an end-user's profile. You can access a user's profile from one of their tickets or by searching for them.

Each ticket tab includes the ticket requester's profile, which contains the user's account data and a list of all of their tickets.

You can also locate users by clicking the **Search** icon (🔍) in the sidebar and searching for the end-user you want to edit.

**Zendesk Classic:** Open a ticket and you'll see a link to the user's profile in the user widget in the right column. Or, use the search in the top toolbar to find the end-user.

**Deleting users**

Deleting users can be done by agents and administrators. Agents can delete end-users and administrators can delete all users (except for the account owner). You cannot delete end-users who are requesters on tickets that are not closed.

**Note:** Deleting a user's account cannot be undone, so be careful to select the correct user when deleting user accounts.

To delete a user

1. Open the user's profile by doing one of the following:
• Click the user's profile from a ticket submitted by that user.
• Click the Search icon (🔍) in the sidebar and search for the user.
  
  **Zendesk Classic:** From a ticket, click the link to the user's profile in the user widget in the right column or use the search in the top toolbar to find the end-user.

2. In the user's profile, click **User options** in the bottom toolbar, then select **Delete**.

  **Zendesk Classic:** Select **Actions > Delete user**.

3. When prompted, click **OK** to confirm the deletion. If you want to cancel the deletion, click **Cancel** instead.

### Merging Users

To handle multiple accounts for the same end-user, you can merge one end-user account into another end-user account. You can only merge registered (verified) end-users. Administrator and agent user accounts cannot be merged.

For information, see *Merging a user's duplicate account.*
Chapter 17

Merging a user's duplicate account

Since end-users can submit requests using different email addresses and via social media such as Twitter, it's possible that duplicate end-user accounts can be created in your Zendesk.

The user profile allows you to enter multiple email addresses for a user and then set one as primary, which means that regardless of the email address they use to submit a request, they are properly identified and a new user account is not created.

A duplicate user account can also be created if the end-user submits a request via Twitter and their Twitter account has not been added to their user profile.

To handle multiple accounts for the same end-user, you can merge one end-user account into another end-user account. You can only merge registered (verified) end-users. Administrator and agent user accounts cannot be merged.

**Note:** If your account uses single sign-on and handles user authentication with JWT or SAML, the merge users option is not available. This is because the user accounts are managed outside of Zendesk.

After merging accounts, any tickets created by the duplicate (now merged) account are updated with the primary user account.

**Note:** A merge cannot be undone, so be careful to select the correct user accounts.

**To merge a user's duplicate account**

1. Click the **Search** icon (🔍) in the sidebar.

   **Zendesk Classic:** The search field is in the upper-right of the top toolbar.

2. Enter the name of the user you want to merge in the search box and click the user's name when it appears.

   Alternatively, you can open a user's profile from one of their tickets.

3. Click **User options** in the bottom toolbar, then select **Merge into another user**.
**Zendesk Classic:** Select **Actions > Merge user.**

The Merge tool appears.

4. Enter the user's name and all users that match what you entered are displayed. Select the correct user and then click **Merge.**

5. When prompted, click **Confirm and Merge** to confirm the merge. If you want to cancel the merge, close the window instead.

### How user data is merged

When you merge one user account into another, the tickets owned by the user account being merged become the tickets of the user that account was merged into and the data in each user profile is combined. The following table describes how user profile data is handled as a result of a merge. The user being merged is referred to as the *merging user* and the target of the merge is referred to as the *receiving user.*

<table>
<thead>
<tr>
<th>User ticket and profile data</th>
<th>Merge results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tickets</td>
<td>All of the merging user's requested tickets are now requested by the receiving user. CCs are treated similarly.</td>
</tr>
<tr>
<td>Phone number</td>
<td>Receiving user's value is not affected by merge.</td>
</tr>
<tr>
<td>Direct Line</td>
<td>Receiving user's value is not affected by merge.</td>
</tr>
<tr>
<td>Primary email</td>
<td>Receiving user's value is not affected by merge.</td>
</tr>
<tr>
<td>Secondary email</td>
<td>All secondary email addresses are maintained, merging user's email is added as an additional secondary email address.</td>
</tr>
<tr>
<td>Language</td>
<td>Receiving user's value is not affected by merge.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Receiving user's value is not affected by merge.</td>
</tr>
<tr>
<td>Organization</td>
<td>Receiving user's value is not affected by merge, but note that tickets aren't automatically updated and may maintain old organization values.</td>
</tr>
<tr>
<td>Tags</td>
<td>Merging user's tags are lost.</td>
</tr>
<tr>
<td>Details</td>
<td>Merging user's details are lost.</td>
</tr>
<tr>
<td>Notes</td>
<td>Merging user's notes are lost.</td>
</tr>
<tr>
<td>Picture</td>
<td>Receiving user's value is not affected by merge.</td>
</tr>
</tbody>
</table>
Suspending a user

Users can be suspended, which means that they are no longer able to sign in to your Zendesk and any new support requests you receive from the user are sent to the suspended tickets queue. This can be done by either marking tickets as spam, which deletes the ticket and suspends the user at the same time, or by marking the user as suspended in their user profile. Agents can suspend end-users and administrators can suspend both end-users and agents.

Users are not notified that they have been suspended, they simply cannot sign in anymore. You can unsuspend users, which restores their previous login credentials and access privileges.

To suspend a user

1. Click the Search icon (🔍) in the sidebar.
   
   
   **Zendesk Classic:** The search field is in the upper-right of the top toolbar.

2. Enter the name of the user you want to suspend in the search box and click the user’s name when it appears.
   
   Alternatively, you can open a user’s profile from one of their tickets.

3. Click User options in the bottom toolbar, then select **Suspend access**.

   
   
   **Zendesk Classic:** Select Actions > Suspend access.

Suspended users are flagged as such and they can no longer sign in. Any new support requests received from the user’s registered identities (email addresses, Twitter, etc.) are added to the suspended tickets queue. You can manually release or delete their suspended tickets.

To unsuspend a user, follow the steps above and select **Unsuspend access**.

**Note:** You can also suspend a user from a ticket by marking the ticket as spam. For more information, see **Marking a ticket as spam and suspending the requester.**
A simple and effective way to streamline your workflow is to create macros for support requests that can be answered with a single, standard response. This saves you the time and effort of crafting a separate response to each customer that has the same issue.

Macros can be created from scratch or based on existing tickets. Macros contain actions, which can be updates to ticket properties and comments to both customers and the support staff. Macros are manually applied to tickets by agents.

There are two types of macros: personal macros (created by an agent or administrator for their own use) and shared macros (created by an administrator for everyone’s use). A personal macro is only visible to and can only be used or modified by the agent or administrator who created it. Administrators can create shared macros and also modify all shared macros, regardless of who created them.

Macros can also be organized into categories to help the support staff quickly locate and apply them. For more information, see Organizing your macros.

Zendesk macros to get you started

Zendesk provides a number of macros to get you started.

- **Close and redirect to topics**
  This sets the ticket status to closed if it is an incident of a known problem, informs the requester via a comment that the ticket has been closed and recommends that they visit the forums for more information about the incident.

- **Customer not responding**
  This is a reminder that can be sent to the requester if they have not responded to a request for more information on a pending ticket.

- **Downgrade and inform**
  This tells the requester that the priority of their request has been downgraded to low and that there may be some delay in resolving their request.

- **Take it!**
  This macro is a shortcut for agents to assign a new request to themselves.

These macros can be used as is or edited or cloned so that you can modify and repurpose them as needed.
Applying macros to tickets

Macros are manually applied to tickets and you can apply more than one macro to a ticket. Keep in mind that what one macro does to the ticket can easily be undone by another macro. So why would you apply more than one macro to a ticket? A typical use case is a ticket that contains more than one question or issue, let's say two in this example. You might have set up two macros that both insert a comment into a ticket to answer each issue separately. By applying each macro to the ticket you add two comments and address both issues in a single response.

To apply a macro to a ticket

1. Open the ticket that you want to apply a macro to.
2. Click **Apply macro** in bottom toolbar.
   
   **Zendesk Classic:** Click the **Apply Macro** link in the ticket.
3. Search for or select a macro from your list of macros.

   The actions defined in the macro will be applied to the ticket. For example, ticket fields may be updated and a comment added to the ticket.
4. To apply another macro to the same ticket, click **Apply macro** again and select another macro.
5. Save the ticket updates by clicking **Submit**.

Applying macros to tickets in a view

Just as you can make bulk updates to many tickets at once, you can also apply a macro to more than one ticket using your views. See *Bulk updating, deleting, and merging tickets.*

Creating macros

Unlike triggers and automations, macros only contain actions, not conditions. Conditions aren’t used because nothing is automatically evaluating tickets to determine if a macro should be applied. Agents evaluate tickets and apply macros manually as needed.
Remember, there are two types of macros: personal and shared. Agents can only create personal macros, for their own use.

**Note:** You can create a macro from an existing ticket. For information, see *Creating macros from existing tickets.*

## Creating personal macros

Although only administrators can create the macros that are shared by all the agents in your Zendesk, agents can create macros only for their own use.

**To create a personal macro**

1. Click the **Manage** icon (), then select **Macros**.
   
   **Zendesk Classic:** Select **Manage > Macros**.
2. To create a personal macro, select the **Personal** tab.
3. Click **Add macro**. Enter the title and add actions for your macro (described below in *Building macro action statements*).
4. Click **Create Macro**.

Your personal macros are added to the list of macros available in a ticket.

## Creating shared macros (administrators only)

Administrators create the macros that are shared by all agents in the Zendesk. Administrators can also create macros for specific groups.

**To create a shared macro**

1. Click the **Manage** icon (), then select **Macros**.
   
   **Zendesk Classic:** Select **Manage > Macros**.
2. Select the **Shared** tab.
3. Click **Add macro**. Enter the title and add actions for your macro (described below in *Building macro action statements*).
4. Set the macro's availability (described below).
5. Click **Create Macro**.

### Set the macro's availability

When an administrator creates a macro, they have the option of setting who can access the macro. There are two types of shared macros: all agents your Zendesk and only those agents in a specific group. Like agents, administrators can create personal macros as well. When creating or editing a macro, an administrator sets access to the macro with one of the following options:
Building macro action statements

Using macros you can set ticket properties, add or modify tags, and add comments.

Table 2: Actions

<table>
<thead>
<tr>
<th>Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set subject</td>
<td>You can use this action to replace the ticket's current subject. The ticket status can be set to the following:</td>
</tr>
<tr>
<td>Status</td>
<td>Open indicates that the ticket has been assigned to an agent.</td>
</tr>
<tr>
<td></td>
<td>Pending indicates that the requester has been asked for information and the ticket is therefore is on hold until that information has been received.</td>
</tr>
<tr>
<td></td>
<td>On-hold means that the support request is awaiting a resolution from a third party — someone who is not a member of your support staff and does not have an agent account in your Zendesk. This status is optional and must be added to your Zendesk (see Adding the On-hold ticket status to your Zendesk in the Zendesk Administrator Guide).</td>
</tr>
<tr>
<td></td>
<td>Solved indicates that the customer's issue has been resolved. Tickets remain solved until they are closed.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority can be set to Low, Normal, High or Urgent.</td>
</tr>
<tr>
<td>Type</td>
<td>The type can be set to the following:</td>
</tr>
<tr>
<td></td>
<td>Question</td>
</tr>
<tr>
<td></td>
<td>Incident indicates that there is more than one occurrence of the same problem.</td>
</tr>
<tr>
<td></td>
<td>When this occurs, one ticket is set to Problem and the other tickets that are reporting the same problem are set to Incident and linked to the problem ticket.</td>
</tr>
<tr>
<td></td>
<td>Problem is a support issue that needs to be resolved.</td>
</tr>
<tr>
<td></td>
<td>Task is used by the support agents to track various tasks.</td>
</tr>
<tr>
<td></td>
<td>Note: It's currently not possible to link incident tickets to problem tickets or set task due dates using the task action in macros.</td>
</tr>
<tr>
<td>Group</td>
<td>You can set groups to any of the following:</td>
</tr>
<tr>
<td></td>
<td>(—) is used to unassign a group (if one has already been assigned)</td>
</tr>
<tr>
<td></td>
<td>(current user's groups) is all the groups to which the agent who is updating the ticket belongs.</td>
</tr>
<tr>
<td></td>
<td>Group name is the actual name of the group that is assigned to the ticket.</td>
</tr>
<tr>
<td>Assignee</td>
<td>You can set assignee to any of the following:</td>
</tr>
<tr>
<td></td>
<td>(—) is used to set assignee to no one (unassigned)</td>
</tr>
<tr>
<td></td>
<td>(current user) is the last person to have updated the ticket, which is not necessarily the same person who is assigned to the ticket. The current user (whoever updated the ticket last) changes whenever the ticket is updated.</td>
</tr>
<tr>
<td>Actions</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assignee name</td>
<td>is the actual name of the person assigned to the ticket.</td>
</tr>
<tr>
<td>Set tags</td>
<td>The tags you want to insert into the ticket. The set tag action replaces the current tags. Tags must be separated with spaces. Multi-word tags must be joined with an underscore (for example, about_sales).</td>
</tr>
<tr>
<td>Add tags</td>
<td>The tags you want to add to the existing list of tags (if any). Tags must be separated with spaces. Multi-word tags must be joined with an underscore (for example, about_sales).</td>
</tr>
<tr>
<td>Remove tags</td>
<td>The tags that you want removed from the existing list of tags contained in the ticket (if any). Tags must be separated with spaces.</td>
</tr>
<tr>
<td>Comment/</td>
<td>The text of the email notification.</td>
</tr>
<tr>
<td>description</td>
<td></td>
</tr>
<tr>
<td>Comment mode</td>
<td>Public or Private. Only agents can view private comments.</td>
</tr>
<tr>
<td>Custom fields</td>
<td>Custom fields that set tags (drop-down list and checkbox) are available as actions.</td>
</tr>
<tr>
<td>You can select the drop-down list values and Yes or No for checkboxes.</td>
<td></td>
</tr>
</tbody>
</table>

**Editing and cloning macros**

You can edit and clone macros. Cloning a macro creates a copy that you can modify and repurpose. Agents can only edit and clone their personal macros. Administrators can edit and clone their personal macros and all shared macros.

**To edit a macro**

1. Click the Manage icon in the sidebar, then select Macros.

   **Zendesk Classic:** Select Manage > Macros.

2. Locate the macro you want to edit and click Edit.

3. Modify the title and actions as needed.

4. Click Update Macro.

**To clone a macro**

1. Click the Manage icon in the sidebar, then select Macros.

   **Zendesk Classic:** Select Manage > Macros.

2. Locate the macro you want to clone and click Clone. This command appears when you move your mouse over a macro in the list.

3. Enter a new title for your macro and modify the actions as needed.

4. Click Create Macro.
Creating macros from existing tickets

You can create a macro from an existing ticket, which enables you to, for example, create a standard response to an issue that has already been addressed.

Agents can only create personal macros from tickets. Administrators can create shared macros from tickets.

To create a macro from an existing ticket

1. Open the ticket that you want to create a macro from.
2. Click Ticket options in the bottom toolbar, then select Create as macro.

Zendesk Classic: Select Update and click Submit. After the ticket updates, click the Create as macro link at the top of the page.

3. Enter a title for the new macro and then modify the actions as needed. You might want to rewrite the comment to be less specific to the original request and more appropriate for reuse.

For more information about macro actions, see Building macro action statements.

4. Click Create Macro.
Chapter 21

Organizing your macros

Most Support teams create and use lots of macros. As your list of macros grows, you may find it difficult to quickly locate macros when you’re trying to apply one to a ticket. You can remedy this by organizing your macros into categories. You do this by including the categories in your macro titles and separating them with two colons, as in this example:

```
Macro title
Assign to::me::question
```

The macro title example above indicates that you’re assigning the ticket to yourself and setting the Type property to Question.

After you’ve categorized your macros, you click through the levels of categorization using the Apply macro menu when creating or updating a ticket.

**Zendesk Classic:** In Zendesk Classic, macro categorization looks like this:

Reordering the list of macros

You can also reorder your list of macros, which affects what you see in the macros menu. Agents can only reorder their personal macros. Administrators can reorder their personal macros and all shared macros.

To reorder the list of macros
1. Click the Manage icon ( 그리기 ) in the sidebar, then select Macros.

   Zendesk Classic: Select the Manage menu, then select Macros.

2. Click Reorder. You’ll find this at the end of the list of active macros.

3. Click and drag macros to new locations.

4. Click Done.
Chapter 22

Searching the data in your Zendesk

Searching works pretty much the way that you would expect: you enter search terms and you get results that contain those words. A simple word search for something like 'camera' returns any results from your entire Zendesk (ticket properties, user properties, comments, tags, forum topics, and so on). You can also use filters and keywords to refine your search.

Administrators can search your entire Zendesk and agents can search the tickets and users that they have been given permission to see. For example, if as an agent you are limited to only seeing tickets in the groups that you belong to, you will only be able to see those tickets in your search results. End-users can search the knowledge base, their own tickets, and their organization’s tickets (if they belong to a shared organization).

Simple text searches

You can search your Zendesk by using the search tool. You'll get results that contain those words you enter in the search.

To begin a search

- Click the Search icon (🔍) in the sidebar, then enter your query in the search box.

As you enter the word or words in your search, results are displayed immediately.
Zendesk Classic: The search field is in the upper-right of the top toolbar.

Identifying items in search results

Search results contain colors or icons to indicate each type of search result that is returned. Ticket results are preceded with a colored icon indicating its current status. Here are the corresponding ticket statuses and colors:

- **New**
- **Open**
- **Pending**
- **On-hold**
- **Solved**

Other search results types are preceded with the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User profile" /></td>
<td>User profile. The user's photo appears instead of the icon, if it's available. Administrators and agents have a green circle in the bottom-right corner of their photo or icon; end-user's do not.</td>
</tr>
<tr>
<td><img src="image" alt="Forum topic" /></td>
<td>Forum topic</td>
</tr>
<tr>
<td><img src="image" alt="Organization" /></td>
<td>Organization</td>
</tr>
<tr>
<td><img src="image" alt="Community question" /></td>
<td>Community question</td>
</tr>
<tr>
<td><img src="image" alt="Idea or feature request" /></td>
<td>Idea or feature request</td>
</tr>
</tbody>
</table>

Using search filters

In addition to the full text search, you can narrow your search results using search filters. You can filter on the primary data objects: tickets, users, organizations, and topics. You can also limit your results to the past day, week, month or year.
To refine your search with search filters

- Click the **Search** icon (🔍) in the sidebar, then click any of the options on the left.

  You can select a filter before or after you enter your search query.

---

**Zendesk Classic:** Search filters are not available in the interface but you can use search keywords to refine your search. See **Using search keywords** below.

---

**Using search keywords**

As described in the [Zendesk search reference](#) in the Zendesk Administrator Guide, you can create more complex search statements using search operators and keywords.

You can restrict your searches to just ticket, user, topic, group, and organization data. To do this, you use the data object properties as keywords in a search. For example, the following search returns all pending tickets.

---

Zendesk also supports common search operators that you use when searching the Internet such as: (equals), > (greater than), < (less than), and "" (phrase search).
Searching for user, organization, and group data returns user profiles and group and organization summary pages that display each entity's activity, including tickets.

For all of the details about searching the data in your Zendesk, see the following topics in the Zendesk Administrator Guide:

- Zendesk search reference
- Searching users, groups, and organizations
- Searching tickets
Chapter 23

Providing live chat support with Zendesk Chat

After your Chat channel has been set up and enabled by an administrator, you're ready to accept chat sessions (see Setting up your Chat channel in the Zendesk Administrator Guide).

Customers can initiate chat requests from existing tickets or from a Feedback Tab. From a customer's perspective, the chat functionality is similar to other chat clients, such as MSN Messenger, AIM, Google Talk, or Facebook Chat.

Workflow

If your administrator has enabled chat, end-users can initiate chat from an existing ticket or from the Feedback Tab (if implemented) when an agent is available. A chat request from an existing ticket does not go to the assigned agent, but it goes to all available agents for anyone to accept.

The number of chats that your Zendesk can accept at one time depends on the number of agents who have made themselves and the number of chats that each available agent can accept (according to how the administrator set up chat). So that is:

\[(\text{number of available agents}) \times \text{max number of chats allowed per agent}) = \text{total number of active chats that can be accepted at a given time}\]

This is how it works:

- **If agents are available** when a customer makes a chat request, the request is sent to all available agents. Any agent can accept or ignore the request. The first agent to accept the request begins the chat and the request disappears for the other agents. Depending on how the administrator set up chat, agents might be able to accept multiple chat sessions at once.
- **If agents are not available** when a user tries to make a chat request, the user sees a message saying no agents are available. The user can add a comment to the existing ticket (if one exists) or submit a support request (if there is not an existing ticket).
- **If the request times out or is declined** while a user is waiting for an agent to chat, the user sees a message inviting them to add a comment to the ticket (if they came from an existing ticket) or to submit a support request (if they came from the Feedback Tab). Chat requests time out if they are not accepted within one minute.

Making yourself available for chat

If your administrator has enabled chat, you can make yourself available to accept chat requests from users.
Note:

You must belong to a group to use Chat. Belonging to a group is a requirement to be assigned to tickets; Chat has the same requirement.

When you accept a chat request, you remain available for additional chat requests (unless your administrator has limited the number of chats per agent to one, or you have accepted the maximum number of chats allowed per agent). If you do not want to receive chat requests while you are in a chat session, make yourself unavailable for chat during that time.

To make yourself available to accept a chat request

• Click the Chat icon in the top toolbar, then select Online.

Zendesk Classic: Click the Chat icon in the menu bar, then select Open chat panel. Notice that the Chat icon (●) appears in the top toolbar, indicating that you are available for chat.

To make yourself unavailable for chat

• Click the Chat icon in the top toolbar, then select Offline in the Chat section.

  Zendesk Classic: Close the chat panel.

Monitoring for chat requests

After you make yourself available for chat, you need to monitor for incoming chat requests.

To monitor for chat requests

• Watch for chat request notifications to appear under the Chat icon in the top toolbar.
**Zendesk Classic**: Leave the chat panel open and watch for chat requests. When a user initiates a chat request, the user's name appears in the chat panel.

### Accepting a chat session

You can accept one or more chat sessions at a time, depending on how your administrator set up chat. Once you have accepted the maximum number of chats allowed per agent, you will not receive new chat requests until you finish a chat. You cannot transfer a chat session to another agent.

**To accept a chat session**

1. Make yourself available for chat by clicking **Online**.
2. When you receive a chat request, hover your mouse over the chat request and click **Accept**.
Alternatively, you can click **Ignore** if you do not want to accept the chat.

When you click **Accept**, an auto-reply is sent to the user asking "How can I help you today?"

If you ignore the chat or don't respond within one minute, the user receives a message inviting them to add a comment to the ticket (if they came from an existing ticket) or to submit a support request form (if they came from the Feedback Tab).

3. Type a message, then click **Send**.

Continue the chat as long as needed.

4. If you want to view the ticket associated with the chat or the user's profile, click the ticket number or the user name at the top of the ticket.

New tickets are created at the beginning of a chat so either an existing ticket or a new ticket is available during a chat.

**Zendesk Classic**: You can only view an existing ticket during a chat; new tickets are not created until a chat ends. To view an existing ticket associated with the chat, click the ticket number at the top of the chat panel. To view the user's profile, click the user name on the bottom left of the chat panel.

5. When you are ready to end the chat, click **End Chat**. The user can also end the chat at any time.

### Identifying the user and handling new accounts

End-users who initiate chat from the Feedback Tab are prompted for their name and email address before they send the chat request. They do not have to be registered users to initiate a chat request.

End-users who initiate chat from an existing ticket are already signed in, so they are not prompted for their email address.
Chat requests received from new, unknown users generate new user accounts that include the name and email address the user entered. An unrecognized user might actually be an existing users using an email address that is not in their user profile. In this case, you can merge the new user account with their existing user account. For more information, see *Merging a user's duplicate account*.

### Working with chat tickets

Every chat session is associated with a ticket—either a new ticket or an existing ticket, depending on how the user initiated the chat.

When a user initiates chat from the Feedback Tab a new ticket is created at the beginning of the chat. You can work on the ticket during the chat session.

**Zendesk Classic:** A new ticket is created at the end of the chat. You can work on the ticket after the chat ends.

When a user initiates chat from an existing ticket you can view and edit the ticket during your chat by clicking the ticket number above the chat window.

**Zendesk Classic:** You can view and edit the ticket during your chat by clicking the ticket number at the top of the chat panel.

During an active chat session the chat is not part of the ticket. When a chat session ends, the full chat session is appended to the new or existing ticket as a comment. You can then make necessary updates to the ticket and submit it.

If a new ticket is created and you find that there is actually an existing ticket for the same issue, you can merge the tickets. For more information, see *Merging tickets*.
Searching for chat tickets

You can search for tickets that were generated from chat sessions. You can also search for a user's tickets using their email address.

Use the `via` keyword in a search to search for chat tickets, as follows:

```
via:chat
```

If you want to search for a user's ticket using their email address, you can enter the user's email in your search.

For more information about searching, see *Searching the data in your Zendesk.*
Chapter 24

Taking inbound telephone calls with Zendesk Voice

After your voice channel has been set up and enabled by an administrator (see Setting up Zendesk Voice in the Zendesk Administrator Guide), you are ready to accept live phone calls and voicemails.

The incoming call workflow: how live calls and voicemails become tickets

All of the agents that make themselves available to take calls are added to a pool of available agents. Calls are queued and routed according to the following rules.

1. If a new incoming call exceeds the maximum queue size (see Enabling the voice channel and configuring the general settings in the Zendesk Administrator Guide), the total number of calls that are allowed to wait in the queue, the caller is sent to voicemail.
2. If a new incoming call is within the limits of the maximum queue size, the caller is queued for the next available agent. The caller can dial 1 at anytime to leave a voicemail.
3. If all the available agents are busy with other calls, callers are queued up to the maximum queue wait time (see Enabling the voice channel and configuring the general settings in the Zendesk Administrator Guide). Once they exceed that wait time, callers are sent to voicemail.
4. The next available agent is the one who has been available the longest without accepting a phone call (the most idle agent). This is the agent that receives new incoming calls first.
5. If the most idle agent does not answer the phone within 30 seconds or declines the call, it is placed back into the queue to wait for the next most idle agent. This continues until all available agents have accepted calls. Once this occurs, new incoming calls are handled based on the queue settings, as described in the previous steps.

Until an agent picks up the call, the caller hears the available agents and wait greetings (see Selecting voice greetings in the Zendesk Administrator Guide).

Making yourself available to receive calls

By default, each agent's availability is set to Not Available for live phone calls. When no agents are available, all calls are sent to voicemail and new tickets are automatically created for each. You can review these and complete and assign the tickets based on your workflow.

When you're ready to accept live phone calls, you can make yourself available to answer phone calls within Zendesk and your Web browser.

Instead of answering calls via the browser, you can forward calls to the telephone number in your user profile. To add an agent forwarding number to your profile, click your name in the upper-right
corner, and then click Add Number next to Agent Forwarding. Zendesk Classic: Click Edit in your profile page and add your number.

**To make yourself available to receive calls**

- Click the Voice icon in the top toolbar, then hover your mouse over the Offline button and it will change to Online. Click the button to go online.

![Voice icon](image)

**Zendesk Classic:** Click the Voice icon in the top toolbar, then select an Available option. You can choose to answer calls via the browser or via your personal phone (if you've added the number to your profile).

Notice that the Voice icon (📞) in the top toolbar appears to indicate that you are available for calls.

**Receiving a call**

When you receive an incoming phone call, the call console appears in the upper-right corner.
If you don't answer within 30 seconds or if you decline the call, it is placed back into the queue to wait for the next available agent.

**Zendesk Classic:** If you added an agent forwarding number to your profile and made yourself available to receive calls at that number, rather than through your browser, your phone will ring. You can accept the call by following the voice prompt. You might also need to click **Accept** in the call console, depending on how your administrator set up Voice.

### Identifying the caller and handling new user accounts

Calls received from new, unknown users generate new user accounts that are identified only by the telephone number they are calling from. To communicate via email with these users going forward, you need to ask your callers for their email address while you're on the call with them and then add it to their new user account.

Each user must have a unique telephone number; this is how Zendesk Voice identifies them when they call in. Therefore, the user's profile phone number must be their direct line. If the user hasn't already done so themselves, you should verify that the number they are calling from is their direct line and then select the **Direct Line** option in the user profile, as shown here:
Setting a telephone number as a user's direct line means that the number cannot be used by any other users in the account.

If the caller is an existing end-user and their number has been added to their profile as their direct line, their name is displayed in the call console.

Unknown users can also actually be existing users if they're calling from a telephone number that they haven't added to their user profile. In this case, you can merge the new user account with their existing user account. For more information, see Merging a user's duplicate account.

Accepting a phone call

When you receive a call, you have the option to accept or decline the call. If you don't accept the call within 30 seconds, it is placed back into the queue. Declining the call also places it back in the queue to wait for the next available agent.

To take a call

• Click Accept in the call notification that appears under the Voice icon in the top toolbar.

  Zendesk Classic: Depending on how you are receiving calls, click Accept in the call console or answer your personal phone and follow the voice prompt. If you forwarded the call to your phone, you might also need to click Accept in the call console, depending on how your administrator set up Voice.

When you accept the call, the call console begins recording the call and a ticket is created. While speaking with the caller, you can enter information as needed as a comment in the newly created ticket. The call console remains available at the top of the ticket. During the call you can mute and unmute as needed by clicking the microphone icon in the call console.

To end a call

• Click Hang up in the call console at the top of the ticket. Or, if you've redirected the call to your telephone you can end the call by hanging up.

  Zendesk Classic: Click Hang up in the call console.

In this state, with the call ended and the ticket still open, you're considered to be in wrap up and are unavailable to take more calls. This allows you to complete annotating and setting the ticket properties before moving on to the next call. When you are ready to go back into the pool of available agents, you can make yourself available.

Note: If your administrator has disabled agent wrap-up, then you are immediately available for another call when you finish a call; you do not need to make yourself available.

To make yourself available for another call

• In the Voice console, click Close and accept new calls.
If you do not see this option, then your administrator has disabled agent wrap-up. This means you are immediately available for another call when you finish a call.

Completing the new voice ticket

When you accept the phone call a new ticket is created. You can add a comment to the ticket and update the ticket properties while you speak with the caller.

By default, when you answer a call you are assigned to the ticket. This overrides any triggers you have that also set the assignee.

When a ticket is created, a private comment is immediately added that includes the following call information:

```
Call from: 415-418-7506
Time of call: Sep-08 2011 02:05:15 pm
Answered by: Lawrence Daley
```

The user won't see this comment of course, because it's private, but creating a new ticket fires the Notify requester of received request trigger and sends the user an email notification confirming that a ticket was created. This only occurs if the call is from a known user whose account contains their email address. If the caller is unknown, email notifications aren't sent until you've updated their user profile with their email address.

In the first case you might not want an email notification to be sent until you've updated and submitted the ticket. This can be done, by an administrator, by editing the Notify requester of received request trigger to exclude tickets received from the Phone call (incoming) channel. For more information, see Setting up business rules to track and manage voice tickets in the Zendesk Administrator Guide.
When you update the ticket by clicking **Submit**, the recording of your conversation is added as a new public comment. If you added a public comment with a summary of the support issue, both public comments are added at the same time.

Since two public comments were added, two ticket notifications are sent to the user. Your voice channel can be configured to prevent users from accessing the live call recordings (see *Enabling the voice channel and configuring the general settings* in the Zendesk Administrator Guide). If your administrator has allowed the recordings to be accessible, the user can click a link to the recording from the notification email or by accessing the ticket from the Web portal.

**Note:** Unlike voicemail tickets, live call recordings do not include a transcription.

### When the caller leaves a voicemail

When no agents are available or the incoming calls exceed the maximum queue size or wait time, callers are sent to voicemail. Each voicemail message automatically becomes a ticket. If the call is from a new or unidentified existing user, a new user account is created (you can merge the new account with the user's existing account). Tickets generated from a voicemail message contain the voicemail recording and a transcription. Voicemail messages can be up to 3 minutes long.
In this example the caller is unknown and only identified by their telephone number; therefore they will not receive the received request email notification because the new user account doesn't contain their email address. Existing users who leave voicemails receive a notification just as if they had submitted a supported request via the other ticket channels.

To track all calls that have resulted in voicemails, you can set up a view (see Setting up business rules to track and manage voice tickets in the Zendesk Administrator Guide).

You can either manually, or using business rules, update voicemail tickets as needed and then respond to the caller.

**Note:** Zendesk Voice does not support making outbound calls.

### Merging tickets when a new call is about an existing ticket

You may often find that callers are contacting you about an issue for which a ticket has already been created. To handle this situation, just conduct the call and add comments as needed to the new ticket. You can then merge the new ticket with the existing ticket.

For information about merging tickets, see Merging tickets.

### Forwarding calls to a different phone number

In addition to answering calls via the browser, you can select to forward calls to your office or mobile phone.

**To add a agent forwarding number**

1. Edit your user profile by selecting the User menu, then clicking View profile page.

   **Zendesk Classic:** Click your name in the upper-right corner, then click Edit in your profile page.

2. Add your telephone number, including a plus (+) sign and the country code, to the Agent forwarding option.

   If your telephone number includes an extension, add it to the extension field. If you also use additional key presses, you can also add those to the extension field. For example, if a caller must dial '123' followed by a pound ('#') key, enter '123#'.

---

**Voicemail from Caller (415-418-7506)**

**Call Details**

- Call from: 415-418-7506
- Time of call: Sep-01 2011 01:29:54 am
- Length of phone call: 21 seconds

**Transcription**

Hi ... I need some help with my mondacom xd 89 ... please call me back as soon as possible thanks ... bye
Zendesk Classic: In Zendesk Classic, you can also click **Test Forwarding** to call the phone number you entered and make sure forwarding is working.

3. Click **Save** to save your user profile.

    **Zendesk Classic:** Click **Update**.

### Searching for voice tickets

You can search for tickets that were generated from phone calls and voicemails. You can also search for a user's tickets using their phone number.

Using the **via** keyword in a search you can search for either phone call or voicemail tickets, as in the following examples.

- `via:voicemail`
- `via:phone_call_inbound`

If you want to search for a user's ticket using their telephone number, you can use a search statement like this:

`requester:+14154187506 status:new`

For more information about searching the data in your Zendesk, see **Zendesk search reference** in the Zendesk Administrator Guide.
Making outbound telephone calls using Zendesk Voice

In the new version of Zendesk, you can make outbound calls using Zendesk Voice. This must first be enabled by an administrator, which is described in *Setting up Zendesk Voice* in the Zendesk Administrator Guide.

**Allow outbound calls?**

- ✅ Yes
- 🗓️ No

Agents can place outbound calls to customers. Outbound calling is only available in the new Zendesk interface.

You can use outbound calling and create a new ticket at the same time, you can dial out from an existing ticket, or from a user's profile.

**Outbound call pricing**

Outbound voice pricing works similarly to inbound pricing, where the call cost is determined by the cost of calling out to the customer as well as to the agent. See the *Zendesk Voice pricing* article for details about outbound call pricing.

**Calling from your browser or telephone**

When placing outbound calls you have two options: call from your browser using your internet connection and VoIP (Voice over Internet Protocol) or call using a real telephone. The option to choose either is available in the Voice panel.
To call from your telephone you need to add your telephone number as the Agent forwarding number in your user profile. You do that editing your use profile and then clicking Add number in the Agent forwarding field. You’ll then be prompted to enter your telephone number.

After you’ve added the Agent forwarding number and you’ve selected the Via Phone option in the Voice panel, you can begin making outbound calls using your telephone. When you make a call using your telephone, Zendesk calls your number and after you pick up then calls the requester. When the requester picks up, you're both connected via a voice conference. Keep in mind that while you can make outbound calls using your telephone, you must initiate the call from within Zendesk in your web browser.

Making outbound calls

Making outbound calls is integrated into the Voice/Chat menu, which is available in the top toolbar. A dial pad is added so that you can enter the telephone number you want to call. If you dial out from an existing ticket and the ticket requester's user profile contains a telephone number, you can easily select that number.

To make an outbound call and create a new ticket

1. After outbound calling has been enabled, you'll see the Dialer icon in the Voice panel, which is shown when you click the Voice icon in the top toolbar.
2. Click the **Dialer** icon and you'll see the dial pad.

3. Making outbound calls is supported in many, but not all, countries. If you're dialing outside of your default country, select the new country from the drop-down list.
4. Enter the telephone number by click the numbers in the dial pad and then click **Call**.
5. When your call connects, a new ticket is opened and you can enter comments and set other ticket properties. When you'd done you can disconnect by clicking **Hang up**. If you called hangs up first, this is detected by Voice and the call is terminated.

**To make an outbound call from an existing ticket**

1. Select the ticket you want to use to call the ticket requester.
2. Above the new comment field you'll see the **Voice** icon. If the requester's user profile contains a telephone number, you'll see it by clicking the **Voice** icon. You can then click the number to call the requester. If a telephone number hasn't already been added to the requester' user profile, click the **Enter a number** link and you'll see the dial pad (as in step 2 of the previous procedure).

3. When you're done with the call, click **Hang up**.

**To make an outbound call from a user's profile**

1. Open the user's profile and click the telephone field.
2. Select **Call this number**.

3. The Voice panel will appear from the top toolbar and the user's number is dialed.

**Creating a view of outbound calls**

You can create a view to track all of the tickets created by or containing an outbound call.
Administrators can also create automations and triggers using **Ticket channel is Phone call (outgoing)** condition.

### Searching for outbound call tickets

You can search for both outbound and inbound calls using the `via` search keyword, as shown here:

- `via:phone_call_outbound`
- `via:phone_call_inbound`
Chapter 26

Posting a forum topic based on a ticket

You can create a forum topic from an existing ticket. For example, if you put detailed information in a ticket comment, you can easily create a forum post with that information. The new forum topic will be pre-populated with details from the ticket and ready for you to edit before posting.

Note: You can turn a forum topic into a ticket if you need to. For more information, see Creating a ticket from a forum topic.

To post a ticket as a forum topic

1. Open the ticket you want to make a forum topic.

   Zendesk Classic: If you opened a ticket that is New, Open, Pending, or Solved (not Closed), click Submit in the ticket. You do not have to make any changes before submitting.

2. Click Ticket options in the bottom toolbar, then select Copy to forum.

   Zendesk Classic: If you opened a Closed ticket, click Post to forum at the bottom. If you opened a ticket that was New, Open, Pending, or Solved, click Post as forum topic at the top.

   A new forum topic opens, pre-populated with details from the ticket. The body text includes a link to the original ticket and all comments from the ticket.

3. Make any edits to the forum topic you’d like.

   The body text includes all comments from the original ticket, so you'll probably want to clean it up to make it a forum topic.

4. Click Add.

   The new topic is added to your forums.
Creating a ticket from a forum topic
(Zendesk Classic)

You can easily turn a forum post into a ticket if you need to. This can be useful when users post technical questions or issues in the forums.

Note: You cannot create a ticket from a forum topic in the new version of Zendesk.

The resulting ticket contains the content and comments from the forum post and is linked to the post. Any comments made in the ticket will appear in the forum post.

Note: You can create a new forum topic from an existing ticket. For more information, see Posting a forum topic based on a ticket.

To create a ticket from a forum post

1. Open the forum topic you want to turn into a ticket.
2. Click Escalate to ticket in the widget in the right column.

The new ticket opens with the content and comments from the forum post. A link to the forum post appears at the top.
3. Make any updates to the ticket you'd like, then click Submit.
Chapter 28

Adding a screencast to a ticket or forum topic

You can create and attach a screencast to a ticket or a forum topic. A screencast is a short recording of your screen. It can be up to 2 minutes long if forums screencasting is not enabled or up to 15 minutes long if your admin has upgraded Screenr for forums screencasting. You screencast can include sound or you can mute sound. A screencast is useful for showing customers how to do a task.

Your customers can also create screencasts in one of their existing tickets viewed in the Web portal or when they submit a new ticket through the Feedback Tab or Web portal. This can be useful for a user to show an issue they are experiencing.

**Note:** Screencasting for tickets and the Feedback Tab is available for Plus and Enterprise accounts. Screencasting for forum topics is available for Plus and Enterprise accounts when an administrator upgrades the Screenr Business account for a monthly fee. Screencasting must be enabled by an administrator. For information, see *Enabling screencasting in your Zendesk* in the Zendesk Administrator Guide.

**Adding a screencast to a ticket**

You can add a screencast to a new or existing ticket.

**To add a screencast to a ticket**

1. Open an existing ticket or create a new ticket.
2. Click **Record screencast**.
3. Click **Allow** to allow the screencast applet.
4. When the screencast recorder appears, switch to the application you want to record and position the frame around the area you want to record.

   You can adjust any of the four dotted lines of the frame by clicking one of the handles or you can click the box in the middle of the recording area and drag the frame to a new position.
5. Click the **Record** button, then perform the task you want to record.

6. Click **Done** when you are finished.

7. When the preview appears, review your screencast, if you want, then click **Upload** to attach the screencast to the ticket. If you do not want to upload the screencast you can click **Delete and cancel**.

8. Click **Submit** to update the ticket.

   The screencast appears in the comment as a recording you can play.

---

**To remove a screencast from a ticket**
• After you upload a screencast to the ticket, and before you submit the ticket update, click **Remove screencast**.

You cannot remove a screencast after you have updated the ticket.

To search for a screencast ticket attachments

• Enter the keyword `has_screencast:true` in your search.

This returns all tickets with screencasts. Add additional search terms to find specific screencasts.

You can use the keyword `has_screencast:false` in your search to return all tickets that do not have screencast attachments.

Adding a screencast to a forum topic

You can add a screencast to a new or existing forum topic. You can also add a screencast to a forum comment.

**Note:** Screencasting in forum topics is only available in upgraded Screenr accounts for a monthly fee. An administrator can upgrade the Screenr account and enable this feature.

**To add a screencast to a forum topic**

1. Do one of the following:
   • Open an existing forum topic for editing
   • Add a comment to an existing topic
   • Create a new forum topic

2. Click the **Record screencast** button in the toolbar.

   ![Record screencast button]

   **Note:** If you are presented with payment information when you click the screencast button, then screencasting in forum topics has not been set up by your administrator.

3. Click **Allow** to allow the screencast applet.

4. When the screencast recorder appears, switch to the application you want to record and position the frame around the area you want to record.

   You can adjust any of the four dotted lines of the frame by clicking one of the handles or you can click the box in the middle of the recording area and drag the frame to a new position.
5. Click the **Record** button, then perform the task you want to record.

6. Click **Done** when you are finished.

7. When the preview appears, review your screencast, if you want, then click **Upload** to add the screencast to the forum topic. If you do not want to upload the screencast you can click **Delete and cancel**.

   When the upload is complete, the screencast appears as an object in the body of the forum topic. You can drag the screencast to reposition it, if needed.
8. Click the button to update or add the forum topic or comment.

   The screencast appears as a recording you can play in the forum topic or comment.

To remove a screencast from a forum topic

1. Open the forum topic with the screencast you want to remove.
2. Click Edit for the topic or one of the comments.
3. Select the screencast and delete it.
4. Click Update or Save comment.
If your customers occasionally send support requests to your email address instead of your Zendesk support address, you can pass the email to the Zendesk support address. By passing the email, a ticket is created in Zendesk with the original sender set as the requester. It also creates a new Zendesk account if the user isn't registered.

You have two options for passing the email:

- **Forwarding the email**
- **Redirecting the email**

Redirecting email is not the same as forwarding it. Redirecting preserves the header information so that the email appears to be from the original sender, not from you. A ticket is created in Zendesk with the original sender set as the requester.

If you forward the email, the sender becomes you, not the original sender. Normally, the process creates a ticket listing you as the requester. However, two options are available to set the correct requester on the ticket.

Use this article if you want to handle the occasional email yourself. If you want to redirect all emails sent to an email address (not just the occasional one), see *Forwarding email from other email providers* in the Administrator Guide.

### Forwarding an email

If you forward the email, the sender becomes you, not the original sender. Normally, the process creates a ticket listing you as the requester. However, you can use one of the following solutions to set the correct requester on the ticket:

- **Enabling the forwarding option for agents in Zendesk**
- **Specifying the requester in the forwarded email**
- **Configuring Microsoft Outlook 2007 and 2010**

### Enabling the forwarding option for agents in Zendesk

Your administrator can enable an option in Zendesk that lets you forward an email in your inbox to your support address to create a ticket on behalf of the original sender.

**Note:** Your email address must be registered in your Zendesk user profile. This feature is supported for email clients in western European languages, Hebrew, and Chinese.

**To enable the forwarding option**

1. Log in as an administrator.
2. Click the Manage icon (ева) in the sidebar, then select Agents from the Settings category.
3. Select the Enable email forwarding option from the Email Forwarding category.
4. Click Save.

Specifying the requester in the forwarded email

This solution works for all email clients. It involves inserting a simple Zendesk instruction in the email body that specifies the requester. When creating the ticket, Zendesk reads the instruction and sets the requester you specified.

The solution works only if you're an agent and your email address is registered in your Zendesk account. The command is ignored if the email is forwarded by an end-user. For more information, see Updating ticket properties from your inbox in the Administrator Guide.

1. Select the email in your inbox and click Forward.
2. Enter the following Zendesk instruction at the top of the email body:
   
   ```
   #requester {requester_email}
   
   where {requester_email} is the requester's email address. Example:
   
   #requester gerry5@yahoo.com
   
   Tip: You can copy the requester's address from the Forwarded Message section in the body.
   ```
3. Clean up the email. For example, remove the FWD prefix in the subject line and the Forwarded Message header in the body.

   The requester instruction will be stripped from the ticket automatically.
4. Enter your Zendesk support address in the To field and click Send.

Configuring Microsoft Outlook 2007 and 2010

The Microsoft Exchange email server doesn't currently allow users to redirect individual messages. However, you can use the following workaround. It works for any normal user and doesn't require granting special permissions on the Exchange server.

1. Select the message in your inbox and click Forward.
2. Enter your Zendesk support address in the To field.
3. Click Options tab and click the Direct Replies To button.
4. In the Properties window, change the value in the "Have replies sent to" field to the name of the user submitting the request.

   Tip: Click Select Names to search your Address Book.
5. Close the window and click Send.

   Tip: If you use this command frequently, select File > Options > Quick Access Toolbar, and add the Direct Replies To button to your toolbar.

Redirecting an email

Some email clients can redirect an email as if you never opened it, preserving the header information so that the email appears to be from the original sender, not you.

Note: If your email account is on a Microsoft Exchange server, redirecting a message is not possible currently in any email client. However, you can still forward an email and set the correct requester on the ticket. See Forwarding an email for details.
The following are some email clients that support redirection:

- Microsoft Outlook 2007 and 2010
- Microsoft Outlook:Mac 2011
- Mail (Mac OS)
- Mozilla Thunderbird
- Eudora
- Evolution

Gmail does not currently support redirecting individual emails. You can forward an email instead. See **Forwarding an email**.

If you know how redirect works in other clients, please share the information in a comment at the end of this article.

**Note:** Zendesk can't provide support for third-party email clients. This information is provided as a convenience. Please contact your client provider for support.

### Microsoft Outlook 2007 and 2010

1. Double-click the email in your inbox to open it in a new window.
2. Select **Actions > Resend This Message**.
   
   A warning appears about you not being the original sender of the message.
3. Click Yes.
   
   A message window appears.
4. Enter your Zendesk support address in the To field and click **Send**.

### Microsoft Outlook:Mac 2011

1. Control-click the email in your inbox and select **Redirect**.
2. Enter your Zendesk support address in the To field and click **Send**.

### Mail (Mac OS)

1. Control-click the email in your inbox and select **Redirect**.
2. Enter your Zendesk support address in the To field and click **Send**.

**Tip:** If you use this command frequently, select View > Customize Toolbar, and add the Redirect button to your toolbar.

### Mozilla Thunderbird

1. Install and use the mailredirect plugin at [http://mailredirect.mozdev.org/installation.html](http://mailredirect.mozdev.org/installation.html).
   
   Only Thunderbird 3 or later is supported.
2. Select the message you want to redirect and choose **Redirect** from the Tools menu.
3. Enter your Zendesk support address in the To field and click **Send**.

### Eudora

1. Select the message in your inbox and choose **Redirect** from the Message menu.
2. Enter your Zendesk support address in the To field and click **Send**.
Evolution

1. Select the message in the inbox and choose **Forward > Redirect** from the Actions menu.
2. Enter your Zendesk support address in the To field and click **Send**.
You can view the original email for any ticket created by inbound email from an end-user. Access to the original email expires 30 days after the email is received in your Zendesk. You can download the source if you want to keep it on-hand.

The original email includes the following:

- Text version of the email
- HTML version of the email
- Source header for the email

**Note:** Depending on the end-user's email server settings, you might not see all of this information.

Viewing the original email enables you to see the HTML, including any HTML formatting, in the email. This is especially valuable if the end-user refers to a formatted section in the ticket. For example, if you're viewing a ticket in which the requester refers to code in bold that's causing an issue, you can view the original email from the ticket to see the bold section.

Viewing the source header information for the email can be valuable for troubleshooting email issues in your Zendesk, such as email pass-through and forwarding.

**To view the original email, including full HTML, for a ticket created by inbound email**

1. Open a ticket created by inbound email.
2. Click the **Events** link in the ticket header.

   ![Ticket with Events Link](image)

   The ticket's events and notifications are displayed.

   **Zendesk Classic:** Click the **All events and notifications** link in the comments section.
3. Scroll to the events for the first comment in the ticket, then click **Show email**.
Viewing the original email, including full HTML

The original email appears.

4. View the text version in the **Text** tab, or click **HTML** to view the HTML version or **Source** to view the email source header.

**Note:** Depending on the end-user's email server settings, you might not see the text or HTML version. Some email servers are set so that they do not send that information.

**To download the source for the original email**

1. Open a ticket created by inbound email.
2. Click the **Events** link in the ticket header.

   The ticket's events and notifications are displayed.

   **Zendesk Classic:** Click the **All events and notifications** link in the comments section.

3. Scroll to the events for the first comment in the ticket, then click **Show email**.
4. Click the **Source** tab, then click **Download source** in the upper-right.
Chapter
31

Marking a ticket as spam and suspending the requester

You can mark a ticket as spam and suspend the requester at the same time. Tickets marked as spam are permanently deleted. Suspended users can be unsuspended if necessary.

**To mark a ticket as spam and suspend the requester:**

1. Open the ticket you want to mark as spam.
2. Click **Ticket options** in the bottom toolbar, then select **Mark as spam**.
   
   You will only see this option on tickets where the requester is an end-user.

![Ticket options menu](image)

**Zendesk Classic:** Select the ticket update option **Mark as spam and suspend requester**. You will *not* be prompted to confirm before the ticket is deleted and the user is suspended.

3. Click **Immediately mark as spam** to confirm that you want to continue.

   The ticket will be deleted and cannot be recovered. The requester will be suspended. Alternatively you can click **Cancel**.